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 SoftMed Systems, Inc. is the focused expert in delivering top-ranked 
healthcare information solutions.  With over 2000 customers, SoftMed 
enables healthcare providers to enhance their operations, shorten their 
revenue cycle, improve patient care and achieve an electronic health record 
solution. 
Recognized for superior integration with all major IT vendors, SoftMed 
supports its customers’ goals of expediting chart completion, ensuring 
accurate and timely reimbursements, expediting document imaging, 
streamlining document creation, and maximizing payor compliance and 
organizational quality.   
In business for more than 20 years, SoftMed’s products are found in nearly 
one-third of the facilities on "America's Best Hospital Honor Roll"1 and 
almost two-thirds of the Hospitals & Health Networks "100 Most Wired."2  
Nearly half of the hospitals on Solucient’s 100 Top Hospitals list are SoftMed 
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to www.softmed.com. 
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About ChartScript 
Welcome to ChartScript®, one of several software products from the portfolio of 
comprehensive health information management solutions from SoftMed Systems, Inc.® 

ChartScript is a central database for transcribing documents that works with a personal 
computer, connected to a network, running Microsoft® Windows® and Microsoft Word. 
SoftMed designed ChartScript to increase transcription productivity by providing an 
extensive interface to available demographic data from other systems. ChartScript is 
designed to be run and maintained by transcription and HIM personnel. 

ChartScript is a tool for creating, editing, distributing, and managing transcribed 
medical documents that includes easy-to-use procedures, such as keyboard shortcuts for 
all commands and options. It provides quick access to documents that you can edit and 
reprint.  

All ChartScript functions are organized into menu options that guide you through 
various steps in system operation. Each window shows you how to proceed through a 
clear and consistent set of options related to adding, editing, deleting, or displaying 
information on transcribed documents. 

About This Guide 
This guide is a supplement to your formal ChartScript training. It includes instructions 
for commonly used tasks such as searching for patient demographics and creating 
documents. Instructions for less frequently used tasks, such as maintenance procedures 
and reports, are in ChartScript Help. 

Who Should Read This Guide 
The User’s Guide is for medical transcriptionists and support staff. It shows you the 
basics of searching, retrieving, creating, editing, printing, and importing documents in 
ChartScript. 

 About This Guide 
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Conventions Used in This Guide 
The information in this guide is presented as step-by-step instructions. The steps are 
numbered, and they include illustrations that show what you should see on your 
computer monitor. 

Microsoft Windows lets you do many actions in more than one way, such as choosing a 
command from a menu, clicking a toolbar button, or typing keys on the keyboard. The 
Appendix provides instructions for using the keyboard and the mouse. 

You will also find these other visual cues throughout the guide: 

Convention Usage Examples 

SMALL CAPS Represents a keyboard key 
name 

Press ENTER. 
Press ESC. 

Bold type Names of menus, 
commands, and buttons 

From the File menu, select 
Exit. 

Italic type Place holders for user input, 
document names 

Type password. 
ChartScript User’s Guide 

ALL CAPITALS Device names and 
acronyms 

COM1 
JCAHO 

Where to Find More Information 
If you need more information about specific windows or fields, you can use the 
ChartScript Help as explained in Appendix A, "Microsoft Windows Basics." You may also 
consult the ChartScript electronic documentation library, as explained in Chapter 2, 
"ChartScript Basics." 

For additional assistance, contact the Client Support Center at: 

1-800-234-0422 

Standard support is available Monday through Friday 8:30 A.M. to 8:30 P.M. eastern time.  

SoftMed 24-hour emergency support is available for facilities with an extended support 
contract. If your facility does not have extended support, consult your system 
administrator or SoftMed contract for information on billing policy and rates. 

When you call, please be at a workstation and be prepared to provide the following 
information: 

! Product version number, date, and time. (From the Help menu, select About 
ChartScript.) 

! Type of computer hardware you are using. 
! Windows version and type of network environment. 
! Names of other programs or memory-resident programs running on the 

workstation when the problem occurred. 
! Exact wording of any messages on your monitor. 
! What you were doing when the problem occurred and whether you can reproduce 

the problem. 
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! How you tried to solve the problem. 
If you want information on other SoftMed products, contact SoftMed Sales and 
Marketing at: 

1-800-695-4447
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Verifying Word Settings 
The Microsoft Word settings for AutoRecover and Spelling & Grammar should have to be 
verified only once. To ensure that these options are set permanently for your 
workstation, SoftMed recommends opening Microsoft Word independently of 
ChartScript and then performing the steps listed in the sections that follow. 

Enabling AutoRecover 
As you transcribe, Word can periodically save a temporary copy of your document as a 
safety measure. If your workstation or Word stops responding while you are working on 
the document because of an error, lock-up, or power outage, Word opens the 
AutoRecover copy of the document when you start Word again. This recovered 
document contains your changes up through the last time the temporary copy was 
saved by Word. You can specify if and when Word saves these AutoRecover copies of 
your documents. 

♦ To enable AutoRecover 

1. From the Tools menu, select Options.  
2. On the Options window, select 

the Save tab. Select the Save 
AutoRecover info every check 
box and clear all other check 
boxes.  

3. In the minutes field, type 2. 
Select OK. 

Note: SoftMed recommends a two-
minute save interval so that the most 
you can lose of a document is what you 
typed in the last two minutes before the 
problem occurred. 

See the "Retrieving Interrupted 
Documents" section of Chapter 7 for 
instructions on retrieving AutoRecover 
files. 

CHAPTER 1 

  

Microsoft Word Setup 
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Defining the AutoRecover Location 
You must specify the folder in which Word stores AutoRecover copies of your documents 
while you are transcribing. Knowing the location of this folder on your workstation may 
assist you in retrieving AutoRecover files, should a problem occur. 

♦ To define the AutoRecover location 

1. From the Tools menu, select Options.  
2. On the Options window, select 

the File Locations tab. From the 
File types list, select 
AutoRecover files. Select 
Modify. 

3. On the Modify Location window, 
in the Folder name field, type 
C:\Softmed\Ssiapps\Scr. Select 
OK. 

See the "Retrieving Interrupted 
Documents" section in Chapter 7 for 
instructions on retrieving AutoRecover 
files. 

 

 

 

Setting Spelling and Grammar Options 
You must specify whether Word should automatically check the spelling of words in 
your documents, including words in uppercase. You can also specify whether you want 
Word to check the grammar in your documents. See the "Checking Spelling and 
Grammar" section on page 4-13 to learn how to run spelling and grammar check on a 
document. 

♦ To set spelling and grammar options 

1. From the Tools menu, select Options.  
2. On the Options window, select the Spelling & Grammar tab.  
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3. On the Spelling & Grammar 
tab, under Spelling, select 
Check spelling as you type. 
Clear the Ignore words in 
UPPERCASE check box. If you 
do not want Word to check the 
grammar in your documents, 
under Grammar, clear the 
Check grammar as you type 
check box. Select OK. 

Because many providers use a style in 
which sections of their dictation are 
phrases and sentence fragments, many 
transcriptionists find that grammar 
check is not helpful. Grammar check 
stops on many areas of the document 
that are not complete sentences, even 
though they are stylistically correct for medical documentation. 

Turning off an AutoCorrect Setting 
Transcriptionists who transcribe using Microsoft Word 2000 should verify that the 
Automatically use suggestions from the spelling checker check box is turned off on their 
workstation. This parameter may conflict with the ChartScript abbreviation expander, 
causing abbreviations to expand incorrectly. 

♦ To turn off the Automatically use suggestions from the spelling checker check 
box 

1. From the Tools menu in Microsoft Word, select AutoCorrect. Select the 
AutoCorrect tab. 

2. At the bottom of the window, 
clear the Automatically use 
suggestions from the spelling 
checker check box. 

3. Select OK to return to the 
document. 
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Editing the Word Custom Dictionary 
ChartScript uses the Word spelling and grammar check features when creating or 
editing documents. The spell check feature in Word enables you to add words to a 
custom dictionary file so that they are considered correct in the future. If you add a word 
to the custom dictionary that should not be saved there, use the following procedure to 
remove it. See the "Checking Spelling and Grammar" section on page 4-2 to learn how to 
run spelling and grammar check on a document. 

Note: Make sure that Word is maximized on your workstation before beginning to work 
with ChartScript. 

♦ To remove a word from the Word custom dictionary 

1. From the Tools menu, select Options.  
2. On the Options window, select the 

Spelling & Grammar tab. Select 
Dictionaries. 

3. On the Custom Dictionaries 
window, select CUSTOM.DIC from 
the list of all the custom 
dictionaries available on your 
workstation. 

4. Select Edit. On the dialog box that 
appears, select OK.  

5. The custom dictionary opens as a 
Word document. Add, remove, or 
edit words from the custom 
dictionary.   

6. When you have finished changing 
your custom dictionary, click the 
appropriate X in the upper-right 
corner of the window: 
# If you are using Word 2000, single-click the X. 

7. On the dialog box that appears, select Yes. Word saves the custom dictionary and 
returns to the ChartScript document.  

Word deactivates automatic spell checking while the custom dictionary is being edited. 
You must reactivate automatic spell checking when you return to your document. 
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♦ To reactivate automatic spell checking 

1. From the Tools menu, select Options. 
2. On the Options window, select the Spelling & Grammar tab.  
3. Select Check spelling as you 

type. Select OK. 
4. Complete your ChartScript 

document, run spell check, and 
save as usual.
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Starting ChartScript 
The first time you start ChartScript, you must create a central user name and password, 
and then link your central user name to your ChartScript user name.  

♦ To start ChartScript for the first time 

1. Start SSIMenu. 
2. On the Login window, select Create Login ID.  
3. On the New Central Login ID 

window, type a new login ID, 
your first name, and your last 
name. Type a password in the 
Password and Confirm 
Password fields. Select OK.  
Note: Use this login ID and 
password the next time you 
start SSIMenu. 

4. On SSIMenu, select 
ChartScript. 

5. On the ChartScript Login 
window, type your ChartScript 
password and then select OK. 
Note: If your SoftMed system 
has been converted, your old 
password should still be active. 
If you are a new user, your ChartScript administrator must tell you your 
password. 

7. On the Link to Central User 
Table dialog box, confirm that 
you are linking to the correct 
ChartScript user and select 
Yes. If you are not linking to 
the correct user, select No and try entering your ChartScript password again. 

CHAPTER 2 

  

ChartScript Basics 
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♦ To start ChartScript after the first time 

1. Start SSIMenu. 
2. On the Login window, in the User ID and Password fields, type the login ID and 

password you created in Step 3 on the previous page. Select OK.  
3. On SSIMenu, select ChartScript. The ChartScript main window appears. 

The ChartScript Main Window 
  

 

 

 

 

 

 

 

 

 

ChartScript Electronic Library 
SoftMed provides access within its programs to all documentation available about those 
programs. ChartScript includes an electronic library that enables you to view all 
ChartScript documents using Adobe Acrobat® ReaderTM version 4.0 or higher. Items 
included in the library are usually documents that were created in paper format. 
Acrobat Reader enables you to view the documents online or to print paper copies. 

Adobe Acrobat Reader version 4.0 or higher must be installed on your workstation in 
order to use the ChartScript online library. If it is not, contact your system administrator. 

Menu bar: 
Click a menu 
name to see 
commands 

Name of current 
user 

Hints for using 
this window 

Toolbar: 
Click to use 
commands 
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♦ To view documents 
electronically 

1. From the Help menu, select 
ChartScript Library. 

2. Adobe Acrobat Reader opens 
a menu of documents 
available for ChartScript. 
From the ChartScript 
document list, select the 
document you want to view. 

The date the document was last 
updated appears in parentheses 
to the right of the document name. If you already have a paper copy of the 
document, check the revision date on the inside of the front cover. If this date is older 
than the date in the library, you may want to print a new copy to ensure that your 
copy is up to date. 

Using ChartScript Help 
ChartScript provides a complete Help system that includes step-by-step procedures for 
users and administrators, along with detailed reference information about windows 
and fields. 

Use the Help menu to display the Help Topics window. From 
this window, you can browse the table of contents, check the 
index, or display a list of topics containing a specific word or 
phrase. 

Displaying ChartScript Help 

♦ To display ChartScript Help by using the keyboard 

1. Press ALT to make the menu bar active. 
2. Press H to open the Help menu. 
3. Press H to display the Help Topics window. 

♦ To display ChartScript Help by using the mouse 

1. From the Help menu, click Help Topics. 
2. Click Contents. 
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Contents Tab 
Use the Contents tab to see a list of all topics organized by categories. The main 
categories appear in the following table: 

Topic Category Description 

Welcome A basic description of the product. 

Basics Basic skills necessary to work with this SoftMed program. 

Using Tasks specific to the product. 

Managing Tasks that only managers or authorized users have rights to 
perform. 

Product Tour Descriptions of windows, menus, and toolbars. 

FAQs Frequently asked questions 

Troubleshooting Suggestions to resolve typical problems. 

Contact Us How to contact SoftMed for support or to give feedback. 
 

♦ To display a topic from the Contents tab 

1. Double-click a book to display the topics. 
2. Double-click the topic that you want to see. 

Index Tab 
Use the Index tab to see a list of topics and related terms in alphabetical order. 

♦ To find a topic on the Index tab 

1. Do one of the following: 
# Type the word you are looking for. The index tab automatically moves to the 

listing that matches the text you type. 
# Scroll through the list of topics. 

2. To display the topic, double-click the topic. 

Find Tab 
Use the Find tab to list all topics that contain a specific word or phrase. 

Note: The first time you use the find feature, select Maximize Search Capabilities, 
select Next, and then select Finish. 

♦ To find topics that include a specific word or phrase 

1. Type the word you want to find. ChartScript Help may show matching words 
(plurals, different capitalization) that you can choose from to narrow your 
search. 

2. The Find tab displays the topics that contain the words you typed. Select a topic 
and select Display. 
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Note: For more information on using 
and selecting options for the Find tab, 
select How to Use Help from the 
ChartScript Help menu. 

Moving Between Help 
Window Tabs 

♦ To move between Help window 
tabs by using the keyboard 

! Do one of the following: 

# Press tab until the open 
tab is selected and then 
press the right arrow key 
or left arrow key to open 
a new tab. 

# Press and hold ctrl and then press tab until the tab you want to view opens. 

♦ To move between Help window tabs by using the mouse 

! Click the tab you want to open. 

 Printing Help Topics 

♦ To print a help topic 

! In an open topic, do one of the following: 

# Select Print. 
# Select Options and then Print Topic. 
# Right-click the topic and select Print Topic. 

Note: You can also select a topic on the Contents tab and select Print. 

♦ To print multiple topics 

1. On the Contents tab, select a book that includes several topics. 
2. Select Print to print all topics under the selected book. 

Pop-ups are the informational boxes that appear when you click on a green link. 

♦ To print a popup 

! Right-click the popup box and select Print Topic. 
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Customizing ChartScript Help 

♦ To change the font size 

1. On a help topic, select Options or right-click the topic 
box. 

2. Select Font, and then select the font size. 

♦ To change where ChartScript Help appears 

1. On a help topic, select Options or right-click the topic. 
2. Select Keep Help on Top. Select On top to keep the help 

topic on top of other windows. Select Not on Top to 
keep the help topic behind other windows. 

The annotate feature provides a way for you to customize a Help topic so that 
information specific to your facility is available. For example, you may want to add some 
tips for typing patient demographic information. After a note is created, it may appear 
to all users who access the Help system. Check with your ChartScript administrator to 
find out whether other users at your facility can view your Help annotations. 

♦ To create a note 

1. Open a Help topic. 
2. Do one of the following: 
# Right-click and select Annotate from the menu. 
# From the Options menu, select Annotate. 

3. On the Annotate window, type a 
note, and then select Save. 

 
 
 
 
 
 
 
 

A paper clip icon appears at the top of 
the topic indicating that a customized 
note exists. 

♦ To read a note 

1. Open a Help topic. 
2. Click the paper clip to display 

the text entry box where the 
note was typed. 

3. If needed, select Delete to 
erase the note. 
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♦ To read more information on using ChartScript Help 

1. From the ChartScript Help menu, select How to Use Help. 
2. On the Contents tab, expand the Using Help category. 

Displaying the Login Window 
If you must leave your workstation but do not want to quit ChartScript completely, you 
can log out of ChartScript to protect confidential information. Displaying the Login 
window ends a ChartScript session without completely exiting the program. 

♦ To display the login window 

! From the Options menu, select Log In. The ChartScript Login window appears. 

 Changing a Central User ID or Password 
You can change your current password and user information. If you do not remember 
your current password, a manager must change your password in the Central User Table 
using a different procedure. 

♦ To change your password or user information 

1. On SSIMenu, from the Options menu, select Change User Info. 
2. On the Modify Central User Information window, change any of your central 

user ID information. 
3. Select OK when you are finished. 

Quitting ChartScript 
♦ To quit ChartScript 

1. On the ChartScript toolbar, select Exit. 
2. On the dialog box that appears, select 

OK to close the ChartScript window 
and return to SSIMenu. 

The rest of this guide provides specific 
information about using basic ChartScript 
functions. More information about using 
ChartScript is available in ChartScript Help. 
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There are many different sources that ChartScript can search when creating or editing a 
document. This chapter reviews all of them. 

ChartScript provides four ways to search for patient records: 

! Using the ChartScript search feature. ChartScript will search for additional 
demographic information in ChartLinc, ChartID, ChartFact, ChartLocator, and 
ChartScript. Your ChartScript administrator determines whether and in what order 
these programs are searched. 

! Using the SoftMed Digital Dictation System Interface (DDSI) 
! Using the SoftMed VoiceScript dictation system 
! Using ChartScriptMD records 

Because each facility has its own procedures, check with your ChartScript 
administrator for details on how your facility is set up. 

You can search for patient records using the following fields: 

! Order Number  
! MR Number  
! Billing Number 
! Patient Name  

! Date of birth 

Notes: 
# Date of Birth must be an indexed field in the patient interface to use this 

field as a search field. Please contact a SoftMed Systems representative to 
make this change. 

# Select Soundex to search for patient names with similar spellings. For 
example, if you type Smith and select Soundex, ChartScript finds similar 
spellings such as Smythe. 

# If your facility has SQL Orders enabled, the Order Number field will be 
replaced by a SQL Order Numbers field when searching in add and edit 
mode.  

CHAPTER 3 

  

Searching for Patient 
Records 
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Some facilities use the following additional demographics: 

! EPI Number 
! Facility Code 

Using the ChartScript Search Feature 
♦ To use the ChartScript search feature 

1. From the ChartScript toolbar, select Add. 
2. On the Search for and Add 

Documents window, do one 
of the following:  
# To search for a dictation 

record, select DDSI (F5). 
Go to the DDSI section of 
this chapter to complete 
your search. 

# To search for a ChartScriptMD record only, select ChartScriptMD (F6). If your 
facility uses VoiceScript also, select VoiceScript (F6) to search for a 
ChartScriptMD or VoiceScript record. Go to the “ChartScriptMD” and 
“VoiceScript” sections of this chapter to complete your search. 

# To search the patient interface, ChartScript, ChartFact and ChartLocator, or 
ChartID, type your search criteria into the fields and select Search (F4). Go to 
the section corresponding to each product to complete your search. 

The sections that follow describe the different windows that appear depending on the 
databases that ChartScript searches for patient records. 

You may search the patient interface for patient and visit information. If your facility 
does concurrent chart analysis, you may search ChartFact and ChartLocator for patient 
information. If you want to copy demographic information from an existing document 
to a new one, you may search ChartScript. The sequence of these searches depends on 
your facility’s preferences. Contact your ChartScript administrator for details. 

Note: A couple of shortcuts that can make your search easier are the following. To clear 
all search fields, select CTRL+SHIFT+C. To recall your last successful search  (the last 
search that produced results) in the current session, select CTRL+L. 

Searching for DDSI Jobs 
If your facility uses DDSI, use this procedure to search for dictation jobs. If your facility 
does not use DDSI, disregard this section. 

♦ To search DDSI 

1. From the toolbar, select Add.  
2. On the Search for and Add 

Documents window, select DDSI 
(F5).  
One of the following occurs: 
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# If only one job is found that is assigned to you, ChartScript automatically 
selects the job, searches for a patient interface record, and displays the Add a 
Document window. 

# If multiple jobs are found 
that are assigned to you, 
the Jobs Assigned to You 
window appears. Select a 
dictation job and then 
select OK to create the 
document. 

 
 
# If no jobs are assigned to 

you in the DDSI queue, the 
prompt appears at left 
appears. 
Select Search. Type your 
search criteria into one of 
the three fields and select 
Search. Select a job from the search results and select OK. The Add a 
Document window appears. 

If a DDSI job for your ID enters the queue, this window disappears and the 
Dictation Jobs Assigned to You window appears. To search for a job 
manually, select Search 
and the Search Dictation 
Interface window appears. 
Type your search criteria 
and select Search. 

Facilities using a Lanier 
digital dictation system 
version prior to version 
7.3 are not automatically 
assigned jobs and must 
search by job number. 

Note: Select Unassigned Jobs to view all unassigned DDSI jobs. Your ChartScript 
administrator defines which transcriptionists can view all DDSI jobs. 

Searching by Order Numbers 
If your facility uses VoiceScript or ChartScriptMD and types documents that have order 
numbers associated with them, such as radiology or cardiology, the Order Number field 
will change to Order Numbers.  



 

                   Chapter 3: Searching for Patient Records  3-4 

Searching for Jobs from ChartScriptMD 
If your system also has VoiceScript, skip to the next section on searching for jobs from 
VoiceScript for information on how to retrieve ChartScriptMD jobs.  If your facility does 
not use ChartScriptMD, disregard this section. 

♦ To search ChartScriptMD 

1. From the toolbar, select Add.  
2. On the Search for and Add 

Documents window, select 
ChartScriptMD (F6).  

3. One of the following occurs: 
# If only one job is found 

that is assigned to you, 
ChartScript automatically selects the job, searches for patient demographics, 
and displays the Add a Document window. 

# If no jobs have been assigned to you, the Search Dictation Interface window 
appears, enabling you to search by Job Number or other criteria. 

# If multiple jobs are found 
that are assigned to you, 
the Jobs Assigned to You 
window appears. Note: 
The Addm column 
indicates if the job is an 
addendum. 

4. On the Jobs Assigned to You 
window, you have the following options: 
# Select Search (F5) to display the Search Dictation Interface window, where 

you can perform the standard search for patient information in SoftMed 
databases.  You also can filter the search results to include only jobs that are 
addenda. 

# Select Print to display the Printer Setup window, where you can print the 
list of ChartScriptMD jobs. 

# Select OK to create the document. 
If the job you selected includes dictation, the dictation player 
appears also. You can listen to the job now or after you begin 
transcribing. The player remains visible until you save the 
document and can be moved around the desktop. 
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Select ? in the upper right corner of the dictation 
player dialog box to view a help window that lists 
keyboard commands for operating the dictation 
player. Select OK to close the WavePlayer Help 
window.  

# Select Add (F3) to complete the 
displayed document. 

# Select Search (F4) to perform the 
standard search for patient 
information in SoftMed databases. 

 

 

Searching for VoiceScript Dictation Jobs 
If your facility uses ChartScriptMD and VoiceScript or VoiceScript alone, follow this 
procedure to search for ChartScriptMD or VoiceScript jobs to complete. If your facility 
does not use VoiceScript, disregard this section. 

♦ To search ChartScriptMD and VoiceScript (or VoiceScript alone) 

1. From the toolbar, select Add.  
2. On the Search for and Add 

Documents window, select 
VoiceScript (F6).  

 

 

3. On the Playback Preference 
dialog box, select the method by 
which you will listen to 
dictation.  Select from one of four 
options:  
Note: Contact your ChartScript 
administrator if you are unsure 
about which option to select. 

# Digital playback through 
ChartScript. This is the default and the most commonly used of the three 
options. By selecting this option, a dictation player appears, enabling you to 
listen to dictation from your workstation. 

# Analog playback through Voice Modem. Select this option if you listen to 
dictation through a telephony device by dialing up using a voice modem. 
With this option, you can specify your own VoiceScript settings from the 
Options menu. See Appendix F, “VoiceScript Settings” for more details. 

# Analog playback through ChartScript. Select this option if you listen to 
dictation through ChartScript using an analog phone. Playback is controlled 
through the foot pedal or keystrokes made on the workstation. 

# Analog playback through telephone. Select this option if your facility is 
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configured to listen to dictations using a telephony device. Playback is 
controlled through the telephone. 

If you select the Digital Playback through PC option, follow the information after 
Step 4 in the previous “Searching for Jobs from ChartScriptMD” section to 
continue adding a document. 

4. One of the following occurs: 
# If only one job is found that is assigned to you, ChartScript automatically 

selects the job, searches for a patient interface record, and displays the Add a 
Document window. 

# If multiple jobs are found that are assigned to you, the Jobs Assigned to You 
window appears. Select a dictation job and then select OK to create the 
document. Note: The Addm column indicates whether the job is an 
addendum. 

# If there are too many records to display, a message appears and you must 
narrow your search criteria. 

Using Patient Interface Record Search Results 
If your facility uses ChartLinc or a 
batch patient download, and 
ChartScript finds interface records 
from your facility’s mainframe that 
match your search criteria, the 
Patient Interface Records Found 
window appears. If your facility does 
not use ChartLinc or a batch patient 
download, disregard this section. 

 

 

 

Following is a description of the toolbar buttons on the Patient Interface Records Found 
window. 

Button Description 

 

Selects the demographic information in the selected interface 
record. 

 (F4) 

Continues the search for patient records in other SoftMed 
programs. 

 (F5) 

Displays the Interface Record Fields window, which displays the 
demographic information in the selected interface record. 

 

Displays the Printer Setup window, which enables you to print 
the list of records on the Patient Interface Records Found 
window. 
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Using ChartScript Search Results 
If ChartScript finds documents in the 
ChartScript database with 
demographic information that 
matches your search criteria, the 
ChartScript Documents Found pane 
appears on the lower portion of the 
Search for and Add Documents 
window. 

Note: To sort the list of documents 
found by a different field, click on the 
column heading of the desired field. 

Following is a description of the 
toolbar buttons on the ChartScript Documents Found pane. 

Button Description 

 (F5) 

Selects the demographic information in the selected document. This 
button copies information only from the fields that should not 
change during the patient’s current visit, such as admission date 
and patient type. 

 (F2) 

Displays the contents of the selected document. You cannot edit the 
document, but you can copy the document’s text to the clipboard. 

 (F3) 

Selects the demographic information in the selected document. This 
button copies only information from the fields that should not 
change throughout the life of the patient, such as birthdate or Social 
Security number. 

 (F4) 

Continues the search for patient records in other SoftMed programs. 

 (F6) 

Opens the Fields, CCs, and Orders window, which displays the 
selected document’s demographic information and printing details. 

 (F7) 

Reprints the selected document. You select to print either originals 
and extra copies, or carbon copies. 

 (F8) 

Enables you to view and set the original and extra copies or carbon 
copies batch flags of the selected document. 

 (F9) 

Enables you to switch to Edit mode. 

  

Opens the Printer Setup window, which enables you to print the list 
of documents on the ChartScript Documents Found pane. 
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The following sections describe how a transcriptionist uses the buttons on the toolbar. 

Copying Demographic Fields for the Same Visit  

When you select this button, the values in the demographic fields in the 
document you selected on the ChartScript Documents Found window are copied to the 
corresponding fields of the new document. The demographic fields copied are specified 
by your ChartScript administrator. These fields should include patient and visit 
information that does not change during the same visit. For example, a patient’s 
admitting physician and billing number usually remain the same throughout a visit. 
This information can be copied from an existing document to a new document using 
Same Record. 

Viewing Documents  

You can view a document without opening it in Word. Use this 
function if you want only to review a document’s text. The document cannot be edited, 
but you can copy the document’s text to the clipboard. The document does not appear 
like it does when printed. For example, heading information may not appear and the 
signature line area may look different. 

♦ To view a document 

1. On the ChartScript Documents Found window, select a document from the list. 
Select View (F2). 

2. On the Viewing window, click 

 to find text in the document. 

Click  to copy selected text to 
the clipboard.  

3. Select Close to close the window. 
 

 

 

 

 

Copying Demographic Fields for the Same Patient  

When you select this button, the values in the patient demographic 
fields in the document you selected on the ChartScript Documents Found pane are 
copied to the corresponding fields of the new document. The demographic fields copied 
are specified by your ChartScript administrator. These fields should include only patient 
information that does not change from one visit to the next. For example, a patient’s 
medical record number and name usually remain the same between visits. This 
information can be copied from an existing document to a new document by selecting 
Same Patient. 
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Continuing the Search for Patient Records  

When you select this button, ChartScript continues to search for patient 
records that match your search criteria in other databases, depending on the SoftMed 
programs your facility uses. Your ChartScript administrator determines whether and in 
what order these other databases are searched. 

Displaying Document Information  

When you select this button, you can display a document’s demographic 
and print information. Use this feature to determine who last edited a document, when 
the document was last edited, the status of carbon copies distribution, whether a 
document is waiting to be batch printed, and so on. 

♦ To display document information 

1. On the ChartScript 
Documents Found window, 
select a document from the 
list. Select Info (F6). The 
Fields, CCs, and Orders 
window appears. Use the 
scroll down arrow to view 
additional information about 
the document. 

2. On this window, you can do 
the following: 

# Select Play Dictation to play the dictation associated with this document. 
This button is only available if your facility is licensed for VoiceScript. 

# Select Display Orders to display order information for this document. This 
button is only available if your facility has activated SQL orders. 

# Select   to copy the contents of the window to the clipboard, or to copy 
the selected text to the clipboard. 

# Select  to print the contents of the Fields, CCs, and Orders window or to 
print the selected text in the window. 

# Select   to preview the contents of the Fields, CCs, and Orders window, 
or the selected text in the window, before printing. 

# Select   to perform a case-sensitive search for text. 

3. Select Close to close the window. 
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Reprinting Documents  

You can choose to reprint a document after it has been created, saved, or 
printed. You select to reprint either original and extra copies, or carbon copies. 

♦  To reprint an original or extra copy 

1. Select the document that you want to reprint and select Print Document (F7) 
from the toolbar at the bottom of the window.  

2. On the Reprint-Document Print 
Configuration window, in the 
What to Print section, select 
Originals/Extra Copies. 

3. In the Print Rule for 
Originals/Extra Copies section, 
select the print rule that you want 
to use to reprint the document. 
Note: If a default print rule is 
associated with the document or 
its document type, that print rule 
is automatically selected and is 
marked by an asterisk (*) in the list of available print rules.  

4. In the Process Via section, select one of the three options: 
# Select Locally if you want to bypass ChartPrint and process the print job on 

your workstation. This option requires that the printer being used is 
installed on your workstation. 

# Select ChartPrint Now if you want to send the reprint request to ChartPrint 
to be processed as soon as possible. 

# Select ChartPrint Later at ___ if you want to send the reprint request to 
ChartPrint to be processed at a later time. This option allows you to indicate 
the time you want the document to be reprinted by ChartPrint. 

5. Select Print to process the reprint job. 
 

♦ To reprint a carbon copy 

1. Select the document that you want to reprint and select Print Document from 
the toolbar at the bottom of the window.  

2. On the Reprint-Document 
Print Configuration window, 
in the What to Print section, 
select CC Distribution. 

3. In the Print Rule for CCs (Print 
Method) section, select the 
print rule that you want to 
use to reprint the document. 
This print rule is used to 
determine the placement of 
footer text on all carbon 
copies, regardless of the 
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distribution method being used. It also determines the printer that will be used 
to print the document for providers that indicate Print as their document 
distribution method. 

4. If the carbon copy you are reprinting will be generated using the Print 
distribution method, in the Envelope Print Rule for CCs section, select No 
Envelopes if you do not want to print an envelope with the carbon copy. If you 
want to print envelopes, select an envelope print rule. 

5. In the Process Via section, select one of the three options: 
# Select Locally if you want to bypass ChartPrint and process the print job on 

your workstation. This option requires that the printer being used is 
installed on your workstation. 

# Select ChartPrint Now if you want to send the reprint request to ChartPrint 
to be processed as soon as possible. 

# Select ChartPrint Later at ___ if you want to send the reprint request to 
ChartPrint to be processed at a later time. This option allows you to indicate 
the time you want the document to be reprinted by ChartPrint. 

6. In the CC Distribution section, click on the provider(s) for whom to generate a 
reprinted carbon copy. 

7. The Result Method column indicates the default distribution method for the 
provider and document type based upon the current settings in ChartScript. If 
you want to generate this carbon copy using an alternative distribution method, 
select Manual Override.  

8. On the Select Override Distribution Method 
dialog box, select the alternative distribution 
method and select OK. The alternative 
distribution method appears in the Manual 
Ov column. 

9. Select Print to process the reprint job. 
 
 

Setting Document Batch Flags  

You can set the batch print flags for a document’s original and extra 
copies or for a document’s carbon copies. Setting a batch flag specifies that the 
document will be included in a batch print if the document’s demographic information 
matches the batch print’s selection criteria. 

Removing a batch flag specifies that the document will not be included in a batch print. 
This feature might be useful if you want to reprint a document now and stop the 
document from printing later in a scheduled batch. In this example, you would reprint 
the document, then remove the document’s batch flag. 

♦  To set a document’s batch flags 

1. On the ChartScript Documents Found window, select a document from the list. 
Select Batch Flags (F8). 

2. On the Batch Print Flags dialog box, select the Original/Copy check box to set 
the batch flag for the document’s original and extra copies. Select the CC 
Distribution check box to set the batch flag for the document’s carbon copies. 
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Clear the check boxes to remove the batch 
flags. 

3. Select OK to save your changes and close the 
dialog box. 

Note: If the document does not include carbon copies, 
this button simply sets or removes the batch print flag 
for original and extra copies; the Batch Print Flags 
dialog box does not appear. For more information on printing documents, see the 
“Printing Functions” chapter in the ChartScript Management Guide. 

Switching to Edit Mode  

Select this button to switch to Edit mode so that you can make changes 
to a selected document.  

Printing the List of ChartScript Documents Found  

You can print the list of ChartScript documents found that match your 
search criteria. 

♦ To print the contents of the ChartScript Documents Found window 

1. On the ChartScript Documents Found window, select Print Results. 
2. On the Printer Setup window, 

select a printer and other 
print specifications. 

3. Select Print. 
 

 

 

 

 

 

Using ChartFact and ChartLocator Search Results 
If your facility uses ChartFact and 
ChartLocator, and ChartScript finds 
patient records in the ChartFact and 
ChartLocator database that match your 
search criteria, the following windows 
appear. If you search by patient name, 
ChartScript finds the name that you 
typed in ChartLocator. A window like the 
one shown at right appears. 

If your facility does not use ChartFact or 
ChartLocator, disregard this section. 
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After you select the correct 
patient, ChartScript searches 
ChartFact, and a window similar 
to the one at right appears. 

Following is a description of the 
toolbar buttons on the 
ChartLocator Records Found 
window. 

 

 

 

 

Button Description 

 

Selects the demographic information in the selected 
ChartFact/Locator record. 

 (F4) 

Continues the search for patient records in other SoftMed programs. 

 

Opens the Printer Setup window, which enables you to print the list 
of documents on the ChartLocator Records Found window. 

  

Using ChartID Search Results 
If your facility uses ChartID, and 
ChartScript finds patient records in 
the ChartID database that match your 
search criteria, the ChartID Records 
Found window appears. If your 
facility does not use ChartID, 
disregard this section. 
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Following is a description of the toolbar buttons on the ChartID Records Found window. 

Button Description 

 

Selects the demographic information in the selected ChartID 
record. 

 (F4) 

 Continues the search for patient records in other SoftMed 
programs. 

 

Displays the Printer Setup window, which enables you to print 
the list of documents on the ChartID Records Found window. 
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This chapter will lead you through the process of creating a document in ChartScript. 

Before you transcribe a document, ChartScript prompts you for three types of 
demographic information: 

! Patient information, such as name and birthdate 
! Visit information, such as admitting physician and admission date 
! Dictation information, such as dictation date and time 

Demographic information may already exist in a patient record in ChartScript or 
another database. Depending on the SoftMed programs your facility uses, ChartScript 
will search for any existing patient records based on search criteria you type. Refer to 
Chapter 3 for more information on searching. 

Adding Documents Manually 
If your search efforts yield no existing data on the patient you need, you can enter 
information manually. 

♦ To add a document without any prepopulated data 

1. From the ChartScript toolbar, select Add.  
2. On the Search for and Add Documents window, select Add to add the document 

manually. 

CHAPTER 4 

  

Creating a Document 
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Completing the Demographic Information 
After you select a patient record, the Document Type to Use for the Document window 
appears. 

Note: If there are multiple visits for the selected patient, you are presented with a list of 
visits for the patient from which to choose. 

♦ To complete the demographic information 

1. On the Document Type to Use 
for the Document window, 
select the document type from 
the list. If the demographics 
source is DDSI or VoiceScript, 
the document type is available 
as part of the record. You can 
change the document type for DDSI records, but not for VoiceScript documents. 
Select OK. 

Note: To see the list of available document types, press the spacebar or . 

2.  The Add a Document 
window appears. Depending 
on the patient record you 
selected, ChartScript copies 
values to some or all of the 
demographic fields. Type 
values in the appropriate 
blank demographic fields.  
Note Field names in blue are 
required.  

Instructions for populating 
various types of fields are found 
in the “Using Fields on Windows” section in Appendix A, “Microsoft Windows 
Basics.” 

The table below describes the buttons on the Add a Document window. 

Button Description 

 

Opens Word and creates the document using the demographic 
information entered on the window. 

 

Saves the demographic information without creating the 
document. 

 (F3) 

Displays demographic information that has been suppressed. 
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Button Description 

 

Displays the document on a viewer window. 

 

Searches for an interface record and uses the information found 
to replace or populate the demographic information. This 
feature is particularly useful for locating visit-specific 
information that may have been missed or erroneously selected 
during the initial search. See the “Changing Document 
Demographics” section on page 6-4 for details. 

 

Displays ChartScript Help for this window. 

 

Closes the window without saving changes or creating the 
document. 

Searching for Order Records 

. When in the Demographics 
window, the Order Numbers field 
displays how many order numbers 
are associated with the document 
that you are creating.  

 

 

 

Select  and the View/Edit Order 
Numbers window appears, where 
you can view or edit the order 
numbers associated with the 
document that you are creating. 
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Select  and the Orders Search 
window appears, where you can 
search for order numbers to associate 
with the document that you are 
creating. 

To select each order that is 
associated with the document that 
you are transcribing, select the row 
in the results section or use the up 
and down arrow keys and press 
spacebar. A red check mark appears 
next to the selected order records. 
Click Select Orders  to return to the 
demographics window.  

Starting Documents 
After you select the document type 
and complete the demographic fields, you are ready to transcribe the document. 

♦ To start the document 

1. On the Add a Document 
window, select Document. 
Word starts and ChartScript 
merges the demographic 
information with the 
document template. 

2. Type the document. 
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File Menu 
The File menu in ChartScript replaces the Word File menu 
on the Word menu bar. The commands on this menu are 
available only when you enter Word using ChartScript. 
Use these commands when working with documents in 
ChartScript. 

 

 

 

 

 

 

 

ChartScript Toolbar 
The ChartScript toolbar provides easy 
access to the commonly used functions 
on the File menu. Each function is described in this chapter. 

Editing Demographic Information 
While you are transcribing a document, you may determine that an important 
demographic field is incorrect or blank, such as the service date or attending physician. 
To correct any missing or inaccurate demographic fields, use the Edit Demographics 
option. 

♦ To modify demographic fields 

1. From the File menu in Word, select Edit Demographics (CTRL+D). The Edit 
Document window appears showing the demographic information. 

2. Make changes to the appropriate fields. If you suspect that you have chosen an 
incorrect patient interface record, select Interface Record and search for the 
correct information. See the “Changing Document Demographics” section in 
Chapter 6 for details. 

3. After all changes have been made, select Document. The document reappears, 
displaying the newly corrected information. 

Note: Do not attempt to change a demographic field by typing the correction directly 
into the Word document. The Edit Demographics function is necessary to ensure that 
the index used to search for the document is updated to match the contents of the 
document. 
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Editing the CC List 
Use the Edit CC List option to add providers to and remove providers from the 
document’s carbon copy list. 

♦ To add a provider to the CC list 

1. On the File menu in Word, select Edit CC List (CTRL+E).  
2. On the CC List for Document 

window, in the Physician 
field, type a provider’s 
number or all or part of the 
provider’s last name. 
Note: To ensure a faster and 
easier search, type specific 
search criteria. For example, 
typing only “New” may 
retrieve several providers 
with last names that begin 
with “New” in the Select One 
Provider window. However, 
typing “Newman, P” retrieves 
fewer providers, making selection faster and easier.  

3. Select a provider from the search results. 

4. Select  or press ENTER to add the provider to the CC list. 

5. Select OK. 

♦ To remove a provider from the CC list 

1. Select a provider in the CC List box. 
2. Select Delete. 
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Non-ProviderID Copy Requests 
If a carbon copy is requested for a person or entity that is not found in ProviderID, the 
request must be added to the document. 

♦ To add a non-ProviderID physician to the CC list 

1. On the document, place your cursor on the 
first blank line after the CC list. It is 
important that the new entry is outside of 
the bookmark brackets for the CC list. Note: If 
your CC lists are at the end of documents, 
press CTRL+END to move to the bottom of 
the document. 

2. Type the name of the person or entity and 
any special distribution information that is 
mentioned, such as address or fax number. 
Type an asterisk at the end of the line. Note: 
The asterisk alerts staff who handle 
document distribution that these copies are 
special requests. 

3. When saving the document, adjust the number in the Copies prompt to reflect 
the total number of extra copies that were added using this procedure. 

Follow these instructions exactly to avoid deleting or rearranging any 
hidden bookmarks at the end of the document. 

Inserting Addresses from ProviderID 
Some document types, such as letters, may require an address for a person or facility. If 
the person or facility’s name and address are entered in ProviderID, it is easy to retrieve 
this information into the document. 

♦ To insert a ProviderID address into a document 

1. From the File menu in Word, select Insert Address (CTRL+R).  
2. On the Insert Provider Address window, 

in the Provider field, type a provider’s 
number or all or part of the provider’s 
last name. Select Search or press ENTER. 
Note: To ensure a faster and easier 
search, type specific search criteria. For 
example, typing only New may retrieve 
several providers with last names that 
begin with “New” in the Select One 
Provider window. However, typing 
Newman, R retrieves fewer providers, 
making selection faster and easier. 
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3. If you want to add this provider to the CC list as well, select the Add Provider to 
CC List check box. 

4. Select a provider from the search results and select OK. The provider’s name and 
address are merged into the document. 

Viewing ESA Messages 
Providers who are actively using the SoftMed Electronic Signature Authentication (ESA®) 
program to sign documents electronically can send a message to transcription. The 
message feature is intended to communicate instructions for making further 
modifications to an existing document before it is signed. 

If a message is attached to a document, the message appears automatically when you 
open the document. However, if you close the message and need to view it again, you 
can open it manually. 

♦ To manually view a message from ESA 

1. From the File menu in Word, select View ESA Message (CTRL+L). 
2. On the ESA Message window, 

read the ESA message. If 
desired, type a response to 
the provider’s comments or 
add a new message. 

3. Select OK to return to the 
document.  

The following functions are available 
on the ESA Message window. 

 

 

Button Description 

  

Copies selected text to the Windows clipboard. 

  

Prints the message. 

  

Previews the printed appearance of the message. 

  

Searches for selected text in the message. 

  

Erases the message. 
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Button Description 

  

Closes the ESA Message window, accepting any changes to the 
message. 

  

Closes the ESA Message window without saving changes to the 
message. 

  

Displays ChartScript Help. 

Searching ChartScript While Creating a Document 
You can search for existing ChartScript documents and copy text into new documents. 
You can search for and open one existing document while working on a new document 
in Word. 

♦ To copy text from an existing document to a new one 

1. From the File menu in Word, select Search ChartScript.  
2. On the Search for and Edit 

Documents window, enter 
the search criteria for the 
document that you want to 
copy from and select Search. 

 
3. Select a document from the 

results that appear and select 
Open Document. The 
document appears in Word. 
Note: As mentioned earlier in 
this chapter, you can view a 
document without opening it 
in Word by selecting View 
Document. Use this function 
if you want only to review a 
document’s text. The 
document cannot be edited, 
but you can copy the 
document’s text to the clipboard. The document does not appear like it does 
when printed. For example, heading information may not appear and the 
signature line area may look different. 

4. Select the text to copy and press CTRL+C to copy the text. 
5. Do one of the following: 
# To close the second document window and return to the new document, 

select Close Document.  
# To return to the new document while keeping the second document 

window open, select Return to Main Document. To return to the second 
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document, you can press ALT+TAB or click the second document button on the 
Windows task bar. 

6. In the new document, place the cursor where you want to paste the text and 
press CTRL+V. 

Changing the Document Type (While Creating a 
Document) 
Use the Change Document Type option if, after you have started a document, you realize 
that the document type is incorrect. You can copy any text that you have already typed 
to the new document. 

The Change Document Type option is available only in Add mode. You 
cannot change the document type of a saved document. 

♦ To change the Document Type by copying text 

1. Select any text in the body of the document that you want to keep. Do not 
include any sections created automatically by the document type format file, 
such as headers, footers, and merge fields. 

2. From the File menu in Word, select Document Type. 
3. On the Change Document Type 

dialog box, in the Document 
Type field, select a new 
document type and select OK. 

4. On the Add a Document 
window, verify the 
demographic information and select Document. ChartScript creates a new 
document in Word. 

5. Read the Change Document 
Type-Finished dialog box and 
select OK. 

6. In the new document, place 
the cursor where you want to 
place the text from the first 
document and, from the File 
menu, select Paste: Document Type Text.  

♦ To change the Document Type without copying text 

1. From the File menu in Word, select Document Type. 
2. On the dialog box that 

appears, select Yes. 
3. On the Change Document 

Type dialog box, in the 
Document Type field, select a 
new document type and 
select OK. 
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4. On the Add a Document window, verify the demographic information and select 
Document. ChartScript creates a new document in Word. 

If you attempt to paste text into the 
new document, the dialog box at left 
appears. Select OK.  

 

 

Changing the Document Status 
If your document needs additional editing, you can save the document and assign one of 
three statuses: 

! Incomplete 
! Hold 
! Permanent Hold 

Incomplete Status 
Incomplete status means that you need additional information from the physician to 
complete the transcription. If the physician is active in ESA, you can send the physician a 
message.  

This document will print in batch if you flag it for batch print. If your 
facility has Document Upload, documents marked Incomplete will upload 
to the mainframe system. 

♦ To mark a document Incomplete 

1. From the File menu in Word, select Document Status (CTRL+O). 
2. On the Document Status 

window, select Incomplete. 
3. Select OK.  
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4. When you save the document, the 
window at left appears. Select Yes 
to send a message to the physician. 

5. Type the message and then select 
OK. 

Note: When you edit the document, 
ChartScript automatically removes the 
Incomplete status. 

Hold Status 
Hold status means that you need to keep the document out of distribution temporarily 
until you can complete it or verify information. 

The document will not be available in ESA or print in batch if you flag it for 
batch print. If your facility has Document Upload, documents marked on 
Hold will not upload to the mainframe system. 

♦ To mark a document on Hold 

1. From the File menu in Word, select Document Status (CTRL+O). 
2. On the Document Status window, select Hold. 
3. Select OK. 

Note: When you edit the document, ChartScript automatically removes the Hold status, 
which makes the document available for distribution.  

Permanent Hold Status 
Permanent Hold status means that you need to keep the document out of distribution 
indefinitely. Use this status for documents that should never be in distribution or that go 
through a series of revisions before being approved for distribution. Documents that are 
on Permanent Hold are not available for batch printing, Document Upload, or ESA. 

♦ To mark a document on Permanent Hold 

1. From the File menu in Word, select Document Status (CTRL+O). 
2. On the Document Status window, select Permanent Hold. 
3. Select OK. 

Editing documents does not remove Permanent Hold status. To remove the 
Permanent Hold status, you must select Remove Status on the Document 
Status window. 
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Previewing Documents 
Use Print Preview to see how the document will look when printed. 

♦ To preview the printed appearance of a document 

1. From the File menu in Word, select Print Preview. The Preview window appears. 
2. Use the Preview toolbar at the top of the window to change your preview 

settings. See Word Help for details. Select Close to return to the document. 

Checking Spelling and Grammar 
ChartScript uses the Word spelling and grammar check features when creating or 
editing documents. In addition to the common words placed in the Word standard 
dictionary, your facility has loaded a medical spell checker to assist you in verifying 
medical terminology in the documents that you transcribe. See Chapter 1, “Microsoft 
Word Setup,” for details on setting spelling and grammar options. 

♦ To check spelling and grammar 

1. From the Tools menu, select Spelling and Grammar.  
2. On the Spelling and Grammar: 

English (U.S.) window, use the 
following functions to check the 
spelling and grammar of your 
document: 
# Ignore. Leaves the 

highlighted error unchanged 
and finds the next 
misspelling or grammar 
error. This button changes to 
Resume if you click in the 
document to edit the document. Select Resume to continue checking the 
spelling and grammar. 

# Ignore All. Leaves all instances of the highlighted error unchanged 
throughout the document and continues to check the document. Word 
ignores this spelling error or type of grammatical error throughout the rest 
of the current Word session. 

# Add. Adds the highlighted word in the Not in Dictionary box to the custom 
dictionary. See Chapter 1, “Microsoft Word Setup,” for details on modifying 
your custom dictionary.  

# Change. Click Change to accept the current selection in the Suggestions box, 
or edit the text in the box and then select Change. When the selected error is 
a repeated word, this button changes to Delete, so you can easily remove the 
second instance of the word.  

# Change All. Changes all instances of the word in the Not in Dictionary or 
Capitalization box to the word in the Suggestions box, or edit the text in the 
box and then select Change All. Word changes all instances of the error in 
the active document only.  
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# Options. Displays the Spelling & Grammar Options dialog box, where you 
can open a different custom dictionary or change the rules that Word uses to 
check spelling and grammar. 

# Undo. Reverses the most recent spelling and grammar check actions, one at 
a time. 

3. When the entire document has been 
checked, the dialog box at right 
appears. Select OK to return to the 
document. 

Completing Documents 
After transcribing the document, you have two options when saving it: 

! Flag the document for later batch printing. 
! Print the document immediately. 

Saving and Batch Printing Documents 

♦ To save a document 

1. On the ChartScript toolbar in Word, select Save (CTRL+S).  
2. On the window that appears, 

change the default settings, if 
necessary, and select OK. The 
document type controls the default 
number of copies and whether the 
Batch Print check box is selected 
when the window appears. If the 
check box is selected, the document 
prints the next time someone runs the batch print function. 
Note: At the copies prompt, add any special copies that you need to the default 
number that appears. Examples include unanticipated copies, such as for the 
patient or for a provider not in ProviderID. See the “Non-ProviderID Copy 
Requests” section earlier in this chapter for details. 
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Stat Printing Documents 

♦ To stat print a document 

1. From the ChartScript toolbar, select Print (CTRL+P).  
2. On the Stat Document Printing 

window, select the print rule to use for 
printing the document.  
Note: Use the Long Description section 
of the window to acquire more 
information about each print rule. 

3. If the print rule that you have selected 
includes the printing of carbon copies, 
you can choose to print an envelope 
along with the carbon copies. To 
include the printing of envelopes, 
select the Include Envelopes? check 
box and then select the envelope rule 
that you want to use from the drop-down list in the Envelope Rule field. Select 
Print. 

The following prompts may also appear as part of the stat printing process, 
depending upon how various parameters and features have been configured. 

5. A dialog box like the one at right 
appears if your facility uses 
ChartPrint to process stat print jobs 
and if ChartPrint is currently not 
running. 
Do one of the following and then 
select OK: 

# Select Process via ChartPrint if you want to send the stat print job to 
ChartPrint for processing. Because ChartPrint is currently not running, the 
stat print request will not be processed and printed until ChartPrint 
becomes available. 
Note: If your facility uses ChartPrint and it is not running, you should notify 
the ChartScript administrator. 

# Select Process Locally if you want to bypass ChartPrint in this situation and 
print the stat print job directly on your workstation. This option requires 
that the printer you want to use to print the document be installed directly 
on your workstation. If it is not, you should send the document to ChartPrint 
for later processing. 

6. The dialog box at right may appear for 
originals or extra copies when using some 
print rules. If necessary, modify the number of 
originals or extra copies to be generated with 
this stat print job. Select OK. 
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7. You may also see a dialog box that asks 
questions about batch printing. 
# In the Copies field, type the 

number of extra copies that should 
print if the document is later batch 
printed. 

# Select the Batch Print 
Original/Copy? check box if you 
want the original and any extra copies to be printed as part of a batch print. 
Keep in mind what you have stat printed and whether batch printing the 
original and/or extra copies is necessary so that you do not create duplicate 
originals or extra copies. 

# Select the Batch Print CCs? check box if you want the carbon copies to be 
printed as part of a batch print job. Keep in mind what you have stat printed 
and whether batch printing the carbon copies is necessary so that you do 
not create duplicate copies. 
Note: If the document that you 
are stat printing does not 
contain any carbon copies, the 
dialog box appears as at right, 
because there does not need to 
be a division between the 
distribution of originals and 
extra copies and the 
distribution of carbon copies.  

8. Select OK. The document is stat printed and saved at this time. The Search for 
and Add Documents or Search for and Edit Documents window appears. 

Closing Documents Without Saving 
Occasionally, you may enter a ChartScript Document and decide to “back out” of the 
document without saving it.  

You should never attempt to quit Word by using the X button in the upper 
left corner of the window. Using the X button may cause Word to become 
unstable or to close completely. Use the following procedure to close a 
Word document without saving. 

SoftMed cannot control certain Word functions. Always use the File menu 
to ensure that Word and ChartScript function together properly. 

♦ To close a document without saving 

1. From the File menu, select Exit Document. 
2. On the Exit dialog box, select No. The document is closed and not saved. 
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Creating Addenda 
In the event that a change needs to be made or more information needs to be added to 
an existing document in that has been electronically signed in ESA, an addendum to a 
document can be created, which will then be merged onto the end of the original 
(primary) document. The primary document will not be changed. The addendum will 
also remain its own document for ease of printing and editing if you are only editing or 
printing the addendum and not the primary document.  

When creating an addendum to a document in Signed status, the dictator will identify 
the document as an addendum using DDSI, VoiceScript, and so on. Addenda can only be 
created by facilities that have ESA turned on and only when you are not transcribing a 
ChartScriptMD document.  

Creating an addendum is much like creating a new document. Addenda may only be 
created for signed ChartScript documents. Addenda utilize addenda format files that 
work in the same way as format files do for documents. See the ChartScript 
Management Guide for more information about addenda format files. After an 
addendum is transcribed, it must be sent back to the authenticating provider for 
signature. 

♦ To create an Addendum 

1. From the ChartScript toolbar, select Add. 
2. Search for the signed ChartScript document to which you would like to add the 

addendum. See Chapter 3, “Searching for Patient Records” for more information 
on how to search for documents. 

3. On the ChartScript Documents Found window, select Addendum.  
Note: If any unsigned 
addenda already exist for the 
selected signed document, a 
warning message is 
displayed, including the 
document number(s) of the 
addenda. A warning message 
stating that an addendum 
can only be created for a 
signed document also 
appears if you have chosen an 
unsigned document. 
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The Add a Document 
Addendum window appears. A 
number of fields will already be 
copied from the primary 
document; these fields will be 
read-only and will have a 
yellow background. 
Note: The following fields are 
always read-only in the Add a 
Document Addendum window: 
Document Type, MR Number, 
Patient Name, Billing Number, Admission Date, Discharge Date, Surgery 
Date, Sex, Birthdate, Soc-Sec number, Service Date, EPI Number, Facility, 
Order Number, (and multiple order numbers). 
See the “Setting ChartScript Parameters” chapter of the ESA Management Guide 
for instructions on how to choose and/or change which fields are read-only in 
this window. 

4. Select Document to begin typing the addendum. Once in Word, you will be 
presented with the addendum format file. See the “Document Types” chapter of 
the ChartScript Management Guide for more information on creating addenda 
format files. 
Note: The primary document may be accessed in the second document window 
for any copying or pasting that you would like to do. 

 

 
 

 



 

ChartScript User’s Guide  …….… 5-1

ChartScript Keyboard 
ChartScript uses standard Word keyboard shortcuts and provides additional shortcuts to 
simplify document editing. 

Using SoftMed Shortcut Keys 
The following shortcut keys are either added by SoftMed or modified from the Word 
standard action. 

To Press 

Change document status  CTRL+O 

Display the demographics screen CTRL+D 

Edit abbreviations CTRL+A 

Edit the CC list  CTRL+E 

Expand text insert  ACCENT KEY (`) 

Go to the next jump code CTRL+J 

Insert a provider’s address CTRL+R 

Insert standard text CTRL+N 

Open the ESA message window CTRL+L 

Save document, close Word, and return to ChartScript CTRL+S 

Save and stat print the document CTRL+P 

Disable abbreviation expander CTRL+W 
 

CHAPTER 5 

  

Productivity Features  
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Using Common Keyboard Commands 

Command Press 

Activate Menu F10, then arrow keys or 
ALT+underlined letter. 

Change case SHIFT+F3 

Copy selected text CTRL+C or SHIFT+F2 

Display nonprinting characters CTRL+SHIFT+* (asterisk) 

Exit ALT+F4 

Extend selection F8 

Find text CTRL+F 

Go To CTRL+G or F5 

Hanging indent CTRL+T 

Left indent CTRL+M 

Move text F2 

ChartScript Help F1 

Paste text CTRL+V 

Repeat last find SHIFT+F4 

Repeat the last action CTRL+Y or F4 

Search and Replace CTRL+H 

Show all tabs and hard returns CTRL+SHIFT+8 

Spell check F7 

Thesaurus SHIFT+F7 

Undo the last action CTRL+Z or ALT+BACKSPACE 

 

Deleting Text and Graphics  

To Press 

Delete one character to the left BACKSPACE 

Delete one word to the left  CTRL+BACKSPACE 

Delete one character to the right  DELETE 

Delete one word to the right  CTRL+DELETE 

Cut selected text to the Clipboard CTRL+X 

Undo the last action CTRL+Z 
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Copying and Moving Text and Graphics  

To Press 

Copy text or graphics CTRL+C 

Move text or graphics F2 (then move the 
insertion point and press 
ENTER), CTRL+X 

Paste the Clipboard contents  CTRL+V 

 

Selecting Text and Graphics 
Select text by holding the SHIFT key and pressing the key that moves the insertion point. 

To extend a selection Press 

One character to the right SHIFT+RIGHT ARROW 

One character to the left SHIFT+LEFT ARROW 

To the end of a word CTRL+SHIFT+RIGHT ARROW 

To the beginning of a word CTRL+SHIFT+LEFT ARROW 

To the end of a line SHIFT+END 

To the beginning of a line SHIFT+HOME 

One line down SHIFT+DOWN ARROW 

One line up SHIFT+UP ARROW 

To the end of a paragraph CTRL+SHIFT+DOWN ARROW 

To the beginning of a paragraph CTRL+SHIFT+UP ARROW 

One window worth of text down SHIFT+PAGE DOWN 

One window worth of text up SHIFT+PAGE UP 

To the beginning of a document CTRL+SHIFT+HOME 

 

Formatting Characters  

To Press 

Apply or remove bold formatting CTRL+B 

Apply or remove an underline  CTRL+U 

Apply or remove italic formatting CTRL+I 

Format letters as small capitals  CTRL+SHIFT+K 

Apply subscripts (automatic spacing) CTRL+EQUAL SIGN 
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To Press 

Change the font CTRL+SHIFT+F 

Change the font size CTRL+SHIFT+P 

Increase the font size by 1 point CTRL+] 

Decrease the font size by 1 point CTRL+[ 

Increase the font size CTRL+SHIFT+> 

Decrease the font size CTRL+SHIFT+< 

Underline single words CTRL+SHIFT+W 

Double-underline text CTRL+SHIFT+D 

Change the case of letters SHIFT+F3 

Format letters as all capitals  CTRL+SHIFT+A 

Apply superscripts (automatic spacing) CTRL+SHIFT+EQUAL SIGN 

Remove formatting (plain text) CTRL+SHIFT+Z 
 

Using Jump Codes 
Jump codes are placed within documents as placeholders. If jump codes are placed in a 
document, you may “jump” to the next set of jump codes by typing CTRL+J on your 
keyboard. Jump codes are indicated by two question marks (??). 

Adding Standard Text 
ChartScript has two built-in expander functions that were designed to assist you in 
quickly adding standard text to a document. This section describes the basic features of 
text inserts and abbreviations. To learn more about the advanced features of ChartScript 
expanders, see the “Expander Functions” chapter of the ChartScript Management Guide. 

Text inserts and abbreviations may be shared by all transcriptionists, or they may be 
created and used by each individual transcriptionist. Shared expanders can be used by 
all transcriptionists but not modified. Personal expanders can be used and modified by 
only the transcriptionist who created them. 
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Using Text Inserts  
Use text inserts to add predefined standard text to a document. 

♦ To use a Text Insert 

1. From the File menu in Word, select Text Inserts (CTRL+N). 
2. On the Text Inserts window, 

in the Find Text field, type a 
name for the text insert. The 
preview box shows you the 
text for the name that you 
entered.  

3. Select Insert to place the text 
in the document. 

 
 
 
 

4. If the text insert has inputs 
for you to fill out, a window 
will pop up where you enter 
the answers for the inputs. 

 
 
 
 
 
 
5. Select F5 to preview what the 

inputs will look like in the 
document. 

 

Text Insert Quick Expansion 

Use the Expand Insert feature to add 
text to a document quickly without 
using the Text Inserts window.  

♦ To expand a text insert 

1. In the Word document, type 
the name for the text that you want to insert. 

2. Press the accent key (`) to expand the text in the document. 
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Creating Text Inserts 
You can define a new text insert for personal use. Text inserts are recommended for text 
in the form of a sentence or longer or text that contains a paragraph return or tab. 

♦ To create a new text insert 

1. Type the standard text into the document, placing jump codes (??) in the 
appropriate locations. 

2. Select the text that you want 
to include in the text insert. 
From the File menu in Word, 
select Text Inserts (CTRL+N).  

3. On the Text Inserts window, 
select Add. 

 
 
 
 
 
 
4. Select Yes on the dialog box 

that appears. 
5. On the Define Text Insert 

window, do the following: 
# In the Name field, type an 

abbreviation for the text insert. 
# In the Description field, describe the contents of the text insert. 
# In the Format Mode field, select one of the following format types: 

• Document’s. The text insert uses the document’s format settings when 
it is inserted. Attributes set in the insert, such as bold and italic, are kept, 
but numbered or bulleted lists are lost. 

• Insert’s (except font name/size). The text insert uses the document’s 
font and size settings, but retains other settings in the insert’s 
definition, such as bulleted or numbered lists. 

• Insert’s. The text insert always retains the settings and attributes you 
select in the definition. 
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6. The text that you selected in 
the document appears in the 
Text Insert Definition box. If 
necessary, select Edit Text to 
make changes to the content 
of the text insert. 

7. Select Save. Your new text 
insert appears in the list on 
the Text Inserts window.  

8. Select Close to return to the 
document. 

Using Abbreviations 
Abbreviations are recommended for short terms that have no paragraph returns or tabs. 

♦ To use abbreviations 

1. Type the abbreviation. 
2. Press one of the following keys: 
# period 
# comma 
# TAB 
# SPACEBAR 

Note: To see a list of abbreviations, from the File menu in Word, select Edit 
Abbreviations (CTRL+A). 

Abbreviation Case Sensitivity Rules 

SoftMed recommends typing the long form of most abbreviations in lowercase, so that 
transcriptionists can take advantage of the case sensitivity features that are built into 
the expander. The case of the expanded form of the abbreviation is determined by how 
the short form is typed. The table below shows how the abbreviation expander handles 
case sensitivity. 

Short Form Expands as Case sensitivity 

cc chief complaint lowercase 

Cc Chief complaint sentence case 

CC CHIEF COMPLAINT uppercase 
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Creating Abbreviations 
You can add an abbreviation for personal use. 

♦ To add an abbreviation 

1. From the File menu in Word, select Edit Abbreviations. 
2. On the Abbreviations 

window, select Add. 
 
 
 
 
 
 
 
3. On the Abbreviation Entry 

window, in the Short Form 
field, type the abbreviation 
code. Press TAB. 

Note: The short form must be less 
than 32 characters and can contain 
the letters a-z, the numbers 0-9, and the dash (-) and slash (/) characters. The use of 
other keyboard symbols or punctuation marks is not permitted. You cannot type 
uppercase letters in the short form. 

4. In the Long Form field, type the full text that you want the abbreviation to 
become when it is expanded. Select OK. 

5. On the Abbreviations window, select Save. 

Adding Special Formatting to Abbreviations 

You can apply some formatting to the long form of your abbreviations. The formatting 
options follow the CTRL+key sequences in Word. For example, CTRL+B turns on bold in 
Word. In your long form text, use the caret (^) to designate the beginning and end of 
formatting. For example, ^bpatient^b results in patient. 

Keystroke combinations that use the backslash (\) result in special placement of the long 
form text or the cursor by inserting a backspace, tab, or hard return. 

The following table lists the special formatting that can be added to your abbreviations 
in the Long Form section: 

Special Formatting Keystroke Combination 

Bold ^B 

Underline ^U 

Italics ^I 

Subscript ^= 
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Special Formatting Keystroke Combination 

Superscript ^+ 

Hard Hyphen ^_ (underscore) 

Backspace \b 

Tab \t 

Enter \r 

 

The keystroke combination for bold, 
underline, italics, subscript, and 
superscript should be placed at the 
beginning of the Long Form to turn 
on the text attribute and again at the 
end of the Long Form to turn the 
attribute off. The following example 
shows how bold can be added to a standard heading. 

The keystroke combination for 
backspace should be placed at the 
beginning of the long form so that the 
space between the expanded text and 
the word that was typed previously is 
eliminated. 

 

The keystroke combination for tab or 
enter should be placed at the end of 
the long form so that the cursor is 
placed at either the next tab stop or 
on the next line when the 
abbreviation expander is expanded. 

♦ To edit an abbreviation 

1. From the File menu in Word, select Edit Abbreviations (CTRL+A). 
2. On the Abbreviations window, select the abbreviation that you want to edit and 

select Edit. 
3. On the Abbreviation Entry window, make the necessary modifications to the 

abbreviation. Select OK. 
4. On the Abbreviations window, select Save. 

♦  To delete an abbreviation 

1. From the File menu in Word, select Edit Abbreviations (CTRL+A). 
2. On the Abbreviations window, select the abbreviation that you want to delete 

and select Delete. 
3. On the Delete Abbreviation Entry dialog box, select Yes. 
4. On the Abbreviations window, select Save. 
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Disabling the Abbreviation Expander 

If you choose not to use the abbreviation expander, you can disable it for your current 
ChartScript session. 

♦ To disable the abbreviation expander manually during a ChartScript session 

1. While transcribing a document, press CTRL+W. 
2. Continue typing. The abbreviation expander will not function until CTRL+W is 

pressed again or you exit and restart ChartScript. 
Occasionally, you may come across an individual abbreviation that you want to type but 
not expand. In this instance, you may disable the expander for one abbreviation. 

♦ To disable the abbreviation expander temporarily for one abbreviation 

1. Type the abbreviation into the text of the document. 
2. Press CTRL or END. 
3. Press SPACEBAR. The abbreviation will not expand. 
4. Continue typing. The abbreviation expander will continue to function until the 

above steps are followed again. 
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Searching for Existing Documents 
You can edit previously created ChartScript documents, including those with a report 
status of Incomplete or Hold. You search for an existing document in the same way that 
you search when adding a document; however, you can narrow the search by typing 
values in multiple data fields. ChartScript locates documents in the active ChartScript 
database that match all of the search criteria that you indicate. 

Notes:  

! Search by multiple demographic fields to narrow the search results. 
! Select Mode (F9) on the Search for and Add Documents window to switch between 

Add mode and Edit mode. 

♦ To search for an existing document 

1. On the ChartScript main window, from the toolbar, select Edit. 
2. On the Search for and Edit 

Documents window, type the 
demographic data for the 
search and select Search (F4). 

3. The ChartScript Documents 
Found pane appears, listing 
existing documents that 
contain demographic information that matches your search criteria. 

Notes: 

! Your ChartScript administrator determines which demographic fields appear on the 
ChartScript Documents Found pane. 

! To sort the list by a different field, click the column heading of the desired field. 

CHAPTER 6 

  

Working With Existing 
Documents 
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Documents With SQL Orders 
When searching for existing 
documents, the ChartScript 
Documents Found window displays 
the word MULTIPLE in the Order Field 
for documents that are associated 
with more than one order number. 

 

The word MULTIPLE also appears when 
you select Info to view the Fields, CCs, 
and Orders window.  

 

 

 

 

 

 

To see the order numbers associated 
with the document, select Display 
Orders. 

 

 

 

 

Search via Report Generator 
The Report Generator can produce search results for the Search for and Edit Documents 
window. This feature enables you to search for documents by any field, rather than only 
those listed on the Search for and Add Documents window. 

♦ To search using the Report Generator 

1. From the ChartScript toolbar, select Edit. 
2. On the Search for and Edit 

Documents window, select 
Rpt Gen Search. 

3. On the Search via Report 
Generator window, enter your 
search criteria and select 
Search.  
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The search results appear in the 
ChartScript Documents Found 
pane of the Search for and Edit 
Documents window. 

Below are a few guidelines for 
using Search via Report Generator: 

! When you select Rpt Gen 
Search, any criteria entered on 
the Search for and Edit 
Documents window appears 
on the Search via Report 
Generator window. There is no 
limit to the number of criteria fields that you can enter on the Search via Report 
Generator window. 

! After a successful search, the criteria entered on the Search via Report Generator 
window remain until you change the criteria on the Search for and Edit Documents 
window or close the Search for and Edit Documents window. 

! The Search via Report Generator window enables you to sort search criteria, but you 
cannot group the search results. 

! If you sort by any fields on the Search via Report Generator window, the search 
results are sorted by those fields in the ChartScript Documents Found pane of the 
Search for and Edit Documents window. If you do not sort by any fields on the 
Search via Report Generator window, the search results are sorted by patient name. 

Working With Existing Documents 
Following is a description of the toolbar buttons on the ChartScript Documents Found 
window. The following sections describe how a transcriptionist uses the functions 
available from the toolbar. 

Button Description 

  

Opens a window that enables you to edit the selected document’s 
demographic information. This button is the default button on the 
ChartScript Documents Found window. 

 (F2) 

Displays the contents of the selected document. You cannot edit the 
document, but you can copy the document’s text to the Clipboard. 

 (F3) 

Adds the selected document to the upload queue. This button 
appears if your facility uses Document Upload. 

 (F5) 

Displays the selected document in Word, which enables you to edit 
the document. 

 (F6) 

Displays the Fields, CCs, and Orders window, which displays the 
selected document’s demographic information and printing details. 
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Button Description 

 (F7) 

Reprints the selected document. You select to print the originals and 
extra copies or carbon copies. 

 (F8) 

Enables you to view and set the original and extra copies or carbon 
copies batch flags of the selected document. 

 (F9) 

Enables you to switch to Add mode. 

 (F10) 

Opens the ESA Message window, which displays messages attached 
to the selected document. This button appears if your facility uses 
ESA.  

 (F12) 

Enables you to search for archived documents with demographic 
information that matches your search criteria. This button appears 
if your facility uses RAAS.  

  

Opens the Printer Setup dialog box, which enables you to print the 
list of documents on the ChartScript Documents Found window. 

  

Opens the CC List for Document window, which enables you to add 
providers to and remove providers from the CC List of the selected 
document and set batch flags for specific providers. 

 

Changing Document Demographics 
You can edit an existing document’s demographic information. To change the document 
type, see the “Changing the Document Type” section on page 6-6. 

♦ To change a document’s demographic information 

1. On the ChartScript Documents Found window, select a document from the list. 
Select Demographics. 

2. On the Edit Document 
window, change the 
appropriate demographic 
information. If the 
demographic field that you 
want to change does not 
appear on this window, select 
More Fields to display the 
remaining demographic 
fields.  
Notes: 

# Select View to see the contents of the document without opening it in 
Microsoft Word. 
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# If the document status is R or S, the Dictating Phys, Dictation Date, 
Dictation Time, and Job/Tape ID fields are not editable.  

# If your facility has SQL Orders enabled, the Order Number field is replaced by 
a SQL Order Numbers field when selecting More Fields. 

3. Select Interface Record to search for an 
interface record and use the information 
therein to replace or populate the 
demographic information. This feature is 
particularly useful for locating visit-specific 
information that may have been missed or 
erroneously selected during the initial 
search. Note: If your facility has SQL Orders 
enabled, the Order Number field is replaced 
by a SQL Order Numbers field when 
selecting Interface Record. 

 

 

 

 

 

4. On the Select an Interface 
Record window, type the 
search criteria and select 
Search. 

 

 

 

 

5. On the Select the fields you 
want to use window, select a 
record. Select OK to accept 
the demographic data from 
the interface record for the 
field adjacent to the check 
mark, and return to the 
previous window.  

# Select  to select all 
demographics fields. A 
red check mark appears next to all of the fields. 

# Select  to cancel the selection of all demographics fields. All red check 
marks are removed. 

Note: Click on a field once to cancel the selection, and again to reselect it. 
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6. Do one of the following: 
# Select Document. ChartScript starts Word and displays the document. Verify 

that the demographic information that you changed has changed within 
the document. 

# Select Save to save changes to the demographic information without 
entering the document. 

7. If you selected Document in Step 5, from the ChartScript toolbar in Word, select 
Save to save your changes and close the window. 

Changing the Document Type (After Saving a Document) 
If you save a document with an incorrect document type, you can open the document 
and copy and paste the text to a new document with the correct type. In essence, you are 
creating a new document with a new number. 

♦ To change the type of a saved document 

1. On the ChartScript toolbar, select Add.  
2. Follow the normal steps to add a document. See the “Using the ChartScript 

Search Feature,” “Completing Demographic Information,” and “Starting 
Documents” sections in Chapter 4 for more information. On the Document Type 
to Use for the Document window, type the correct document type. 

3. After ChartScript starts Word, from the File menu, select Search ChartScript. 
4. On the Search for and Edit Documents window, type the search criteria for the 

incorrect document and then select Search. 
5. On the ChartScript Documents Found window, select the document that 

contains the wrong document type and then select Open Document. 
6. Select the text to copy and press CTRL+C. 

Note: Do not select the signature line or CC sections of the document. 

7. Select Close Document to close the second document window and return to the 
new document. 

8. In the new document, place the cursor where you want to paste the text and 
press CTRL+V. 

9. If you need to add providers who should receive carbon copies, from the 
ChartScript toolbar, select Edit CC List. On the CC List for Document window, add 
the providers and then select OK. 
Note: The carbon copy list from the incorrect document does not copy over to 
the new document. You must verify that the names are present on the new 
document. 

10. From the ChartScript toolbar, select Save. 
After you create the new document with the correct document type, you should purge 
the document with the incorrect document type. 
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♦ To purge a document 

1. On the ChartScript main window, from the Documents menu, select Purge 
Documents. 

2. On the Search for and Purge Documents window, type your search criteria and 
then select Search. 

3. On the ChartScript Documents Found window, select the document with the 
incorrect document type and then select Purge. 

4. On the dialog box that appears, select Yes. 

Before purging the document, ensure that the new document is in the 
database.  

Viewing Documents  
You can view a document without opening it in Word. Use this function 
if you want to review only a document’s text. For more information, see the section 
“Viewing Documents” in Chapter 6. 

Adding Documents to the Upload Queue   
You can add a document manually to the upload queue. The Document 
Upload interface moves documents from the queue to the mainframe. 

♦ To add a document to the upload queue 

1. On the ChartScript Documents Found window, select a document from the list. 
Select Upload (F3). 

2. On the Question dialog box, select Yes. 
 
 
 
 
 
 

Editing Documents   

♦ To edit a document 

1. On the ChartScript Documents Found window, select a document from the list. 
Select Edit (F5). ChartScript starts Word and displays the document. Change the 
document’s text. Note: If there is a message from the provider, it appears 
automatically when you open the document. 

2. From the ChartScript toolbar in Word, select Save to save your changes and close 
the window. 

Notes 

! To change any demographic information, see the section “Changing Document 
Demographics.” 
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! You cannot change the document type of an existing document by simply editing 
the document. For instructions on changing the document type, see the “Changing 
the Document Type (After Saving a Document)” section on page 6-6. 

Displaying Document Information   
You can display a document’s demographics and print information. For 
more information, see the section “Displaying Document Information” 
in Chapter 6. 

Reprinting Documents   
You can reprint a document after it has been created, saved, or printed. For more 
information, see the section “Reprinting Documents” in Chapter 6, “Working with 
Existing Documents.” 

Setting Document Batch Flags   
You can set the print batch flags for a document’s original and extra 
copies or for a document’s carbon copies. For more information, see the section “Setting 
Document Batch Flags” in Chapter 6. 

Switching to Add Mode   
Select this button to switch to Add mode.  

Displaying Messages   
You can view any messages attached to the document, including 
messages attached by a transcriptionist via ChartScript, and messages attached by a 
provider via ESA. 

♦ To display messages attached to the document 

1. On the ChartScript 
Documents Found window, 
select a document from the 
list. Select Display Message 
(F10). The ESA Message 
Window appears with the 
messages attached to the 
document. 

2. Do one of the following: 

# Click  to copy the 
contents of the window 
to the Clipboard, or to 
copy the selected text to 
the Clipboard. 
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# Click  to print the contents of the ESA Message window or to print the 
selected text in the window. 

# Click  to preview the contents of the ESA Message window, or the 
selected text in the window, before printing. 

# Click  to perform a case-sensitive search for text. 

3. Select Close to close the window. 

Searching the Document Archives   
If the document that you want does not appear in the ChartScript 
Documents Found window, you can search the document archives, if your facility uses a 
version of the SoftMed Rapid Access Archive System (RAAS®). 

♦ To search the document archives 

1. On the ChartScript 
Documents Found window, 
select Search Archives (F12). 
ChartScript uses the data 
from the Search for and Edit 
Documents window to locate 
archived documents that 
match the search criteria. If 
archived documents are 
found, the Search for 
Documents in the Archives 
window appears. 

2. Select a document from the 
list. 

 The following functions can be executed on an archived document. 

Button Description 

 

Displays the contents of the selected document. See the “Viewing 
Documents” section of Chapter 6 for details.  

 

Adds the selected document to the upload queue so that it can be sent 
to an online data repository. See the “Adding Documents to the Upload 
Queue” section on page 6-7 for details. 

 

Displays the selected document’s demographic information and 
printing details. See the “Displaying Document Information” section of 
Chapter 6 for details. 

 

Reprints the selected document. See the “Reprinting Documents” section 
of Chapter 6 for details. 
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Button Description 

 

Prints the list of archived ChartScript documents found that match your 
search criteria. 

 

Moves a document back into the active ChartScript database. Select 
Restore only if you want to edit the document. If you make changes to 
the document after restoring it, the document will be archived again the 
next time maintenance is run. 

 

Printing the List of ChartScript Documents Found   
You can print the list of ChartScript documents found that match your 
search criteria. For more information, see the section, “Printing the List of ChartScript 
Documents Found” in Chapter 6. 

Editing the CC List   
You can add providers to and remove providers from the document’s CC 
list without editing the document. You can also request a carbon copy of the document 
in the next batch print for specific providers. 

Using this feature, the CC list will be updated on the document if the document has not 
been electronically signed. If the document has been signed using ESA, the CC list can be 
edited, but the changes will not be reflected on the document. You must select the Info 
button to view changes to the CC list that occurred after signature. 

♦ To edit the CC list 

1. On the ChartScript Documents Found window, 
select a document from the list. Select CC List. The 
CC List for Document window appears. The BP-CC 
List area of the window represents two options. 
Providers listed here receive carbon copies of the 
document, and a check mark next to a provider’s 
name indicates that the provider will receive a 
copy during the next batch print. 

2. To add a provider to the CC list, in the Physician 
field, type a provider number or a portion of the 
provider name. Select Search. Select a provider in 

the MD List, then select  or press ENTER to move the provider to the BP-CC List. 

3. To remove a provider from the CC list, select a provider in the BP-CC List, then 
select Delete. 

4. To print a carbon copy for a provider in the next batch print, click the provider’s 
name. A check mark appears next to the provider’s name. 

5. To disable a carbon copy from printing for a specific provider, click the provider’s 
name and the check mark disappears. Select OK to save your changes and close 
the window. 
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Retrieving Interrupted Documents 
If Word unexpectedly shuts down while you are transcribing a document, you can 
retrieve a backup copy. Word automatically saves a copy of your document at regular 
intervals to ensure that it is available for automatic retrieval in the case of a power 
failure or similar problem. 

To use this feature, a time interval must be set on your workstation. For instructions on 
setting this interval, see the “Enabling AutoRecover” section on page 1-1. 

♦ To retrieve an interrupted document 

1. If you receive an error message, print or write down the details and what you 
were doing when it appeared. 

2. Shut down the computer and then restart it. 
3. Start Word outside of ChartScript. The recovered document opens automatically 

with the word “Recovered” in the top left corner of the title bar. 
Note: You should have an icon for Microsoft Word on your desktop. Otherwise, 
from the Start menu, select Programs"Microsoft Word. If you need assistance, 
please contact your Information Services representative. 

4. Highlight the body of the recovered document and select Copy (CTRL+C).  
Note: Do not copy headers, footers, signature lines, and CC lists; copy only the 
body of the document. 

5. From the File menu, select Exit Document to close Microsoft Word. You do not 
need to save the document; however, you may choose to do so as an additional 
safety measure.  

6. Start ChartScript. 
7. On the ChartScript main window, select Add.  
8. Proceed as if you were creating a new document. 
9. On the Add a Document window, recreate the demographics window for the 

document. Select Document. 
Note: The demographics window of an interrupted document is not recoverable 
and must be recreated manually. 

CHAPTER 7 

  

Troubleshooting 
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10. In Word inside ChartScript, place your cursor in the proper location and select 
Paste (CTRL+V) to paste the text into the document. 
Note: The CC list of an interrupted document is not recoverable and must be 
recreated manually by using the Edit CC List function. 

11. Proceed with completing and saving your document. 

Retrieving Lastsave.rtf 
If Word unexpectedly shuts down while you are saving a document using either the save 
(CTRL+S) or stat print (CTRL+P) method, and the above procedure for retrieving an 
interrupted document is unsuccessful, you still can retrieve a backup copy of the 
document through ChartScript. ChartScript saves a copy of your document to a file on 
your workstation named Lastsave.rtf. 

Note: ChartScript saves only one Lastsave.rtf file on the workstation. If you do not 
retrieve the document right away, it will be overwritten the next time Lastsave.rtf is 
created. 

♦ To retrieve Lastsave.rtf 

1. When Word shuts down, click 
OK on the message box that 
appears. Be sure to write 
down the path to the 
document so you can browse 
to it easily. 

2. If you receive an error message, print or write down the details and what you 
were doing when it appeared. 

3. Start Word outside of ChartScript. 
4. From the File menu, select Open. 
5. On the Open window, browse 

to the path given on the 
message box. Select the 
document and select OK. 

6. Highlight the body of the 
recovered document and select 
Copy (CTRL+C).  
Note: Do not copy headers, 
footers, signature lines, and CC 
lists; copy only the body of the 
document. 

7. From the File menu, select Exit Document to close Microsoft Word. You do not 
need to save the document; however, you may choose to do so as an additional 
safety measure.  

8. Start ChartScript. 
9. On the ChartScript main window, select Add.  
10. Proceed as if you were creating a new document. 
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11. On the Add a Document window, recreate the demographics window for the 
document. Select Document. 
Note: As is the case with an interrupted document, the demographics window is 
not recoverable and must be recreated manually. 

12. In Word inside of ChartScript, place your cursor in the proper location and select 
Paste (CTRL+V) to paste the text into the document. 
Note: As is the case with an interrupted document, the CC list is not recoverable 
and must be recreated manually using the Edit CC List function. 

14. Proceed with completing and saving your document. 

Retrieving a “TOO BIG” Document 
To protect your facility's network from 
excessively large documents, ChartScript 
limits document size to 200 KB. If you 
attempt to save a document that is larger 
than 200 KB, a notice will appear. 

♦ To retrieve TOOBIG.RTF 

1. Select OK on the message box that appears. Be sure to write down the path to 
the document so that you can browse to it easily. 

2. Start Word outside of ChartScript. 
3. From the File menu, select Open. 
4. On the Open window, browse 

to the path given on the 
message box. Select the 
document and select OK. 

5. Highlight the body of the 
recovered document and 
select Copy (CTRL+C). 

6. Do not copy headers, footers, 
signature lines, or CC lists; 
copy only the body of the 
document. 

7. From the File menu, select Exit Document to close Microsoft Word. You do not 
need to save the document; however, you may choose to do so as an additional 
safety measure. 

8. Start ChartScript. On the ChartScript main window, select Add. 
9. Proceed as if you were creating a new document. On the Add a Document 

window, recreate the demographics window for the document. Select 
Document. 
Note: The demographics window is not recoverable and must be recreated 
manually. 

11. In Word inside of ChartScript, place your cursor in the proper location and select 
Paste (CTRL+V) to paste the text into the document. 
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Note: The CC list is not recoverable and must be recreated manually using the 
Edit CC List function. 

12. To ensure that you do not receive the TOOBIG message again, remove or adjust 
anything in the document that could be contributing to the large byte size, such 
as graphics, large tables, and so on. Proceed with completing and saving your 
document. 
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With the User’s Documents report, you can view and print a report of your productivity 
over a range of time. This report includes statistics only for the user logged on to 
ChartScript. 

♦ To generate the report 

1. From the Reports menu, select User’s Documents. 
2. Type a start date for the reporting period. 
3. Type an end date for the reporting period. Select OK. 
4. On the Printer Setup window, do one of the following: 
# Select Print to print the report to the selected printer. 
# Select Print Preview to view the report on your monitor. 

6. When previewing the report, select  to print the report. 

7. Select Close to exit the report. 
Note: Your statistics are available for 13 months. 

The Print Preview window at right 
shows a sample Users Documents 
report. 

The Users Documents report provides 
the following information: 

! Title. Displays your name and the 
selected date range. 

! Document Type. Lists the various 
document types that you created 
or edited during the date range. 
Your statistics are indicated for 
each document type. 

! New Documents. Displays the number of documents that you initiated during the 
date range. This column does not include a count of the documents that you edited 
for other transcriptionists during the date range. 

! Lines. Displays the number of lines that you transcribed during the date range. This 
column includes all lines added to documents both when adding new documents 
and when editing existing documents. 

CHAPTER 8 

  

Reporting Your 
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                   Chapter 8: Reporting Your Productivity  8-2 

! Wtd Lines. Displays the number of weighted lines that you transcribed during the 
date range. This column shows the extra credit that you earned for typing 
documents with a high level of difficulty because of the document type, the 
dictating provider or a combination of both. 
Note: For more information about weighting by document type or provider, see your 
ChartScript administrator. 

! Avg Lines. Displays the average number of lines per document for the date range. 
! Avg Wtd Lines. Displays the average number of lines per document for the date 

range after being multiplied by the document type weight and the provider weight 
values. 

! Totals. Displays the grand total of Lines and Wtd Lines for the date range. Also 
indicates the combined Avg Lines and Avg Wtd Lines for all document types. 
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With ChartScript® Express™, you can transcribe documents using a text editor, rather 
than typing directly into Microsoft Word. ChartScript Express can be used by 
transcriptionists using ChartScript or WebLinc Script who do not have the need to access 
all of the features that Word offers in its interaction with ChartScript. You must still have 
Word loaded on your workstation in order to merge the text onto the format file when 
saving the document. The merged text takes on the characteristics of the format file, 
including the font size and style. ChartScript Express can be useful for remote 
transcriptionists who are not able to attend the full ChartScript transcriptionist training. 
ChartScript Express can only be used for adding new documents into ChartScript, not for 
editing current ChartScript documents. 

ChartScript Express is a workstation-specific setting. If a user turns on ChartScript 
Express on their workstation, ChartScript Express will be enabled for any user who logs 
onto that workstation. If the user does not want to use ChartScript Express, they must 
disable it on the workstation. 

Starting ChartScript Express 
♦ To start transcribing in ChartScript Express mode 

1. From the Options menu, select 
ChartScript Express. A message window 
appears letting you know that 
ChartScript Express mode is now 
activated. 

2. Select OK. You now can begin adding 
documents in ChartScript Express mode. 

Adding a New Document in ChartScript Express 
Mode 
The process of adding a document in ChartScript Express is for the most part the same as 
described in Chapter 4 of this guide. There are a few differences to take note of, however. 

After searching for the patient information and selecting a document type, you are 
presented with the ChartScript Express entry window. When working in ChartScript 
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Express mode, the window is split 
horizontally. The upper portion 
contains the required demographic 
fields for that document type and the 
lower portion is the text editor.  

The ChartScript buttons are 
positioned along the right side, and 
function the same way that they 
would in ChartScript Add mode. You 
still have access to the CC manager, 
text inserts, and abbreviation 
expanders. The demographics screen 
is simplified and only contains the 
key fields for the document type and corresponding format file that you are creating. All 
of the other demographics fields are accessible by selecting More Fields.  

The table below describes the buttons on the Add a Document window when working in 
ChartScript Express mode. 

Button Description 

 

Saves the demographic information without creating 
the document. 

 (F3) 

Displays demographic information that has been 
suppressed. 

 

Displays the document in Microsoft Word so that you 
can edit the document.  

Note: After selecting Document, you will not be able to 
re-enter ChartScript Express mode for this document. 

 

Opens the CC List for Document window where you 
can select providers to carbon copy for this document. 

 

Opens the Text Inserts window where you can select 
inserts to add to your document. 

 

Opens the ESA Message window where you can enter a 
message for the provider. 

 

Searches for an interface record and uses the 
information found to replace or populate the 
demographic information. This feature is particularly 
useful for locating visit-specific information that may 
have been missed or erroneously selected during the 
initial search. See the “Changing Document 
Demographics” section on page 6-4 for details. 
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Button Description 

 

Displays ChartScript Help for this window. 

 

Closes the window without saving changes or creating 
the document. 

These buttons that are above the typing window 
control formatting of the text while you are 
transcribing in the window.  

Note: Any formatting that you add may be lost when 
the document is merged with the format file for this 
document type. The format file controls the formatting 
of the text once it is merged. 

Options Menu 
The Options menu in ChartScript Express corresponds to 
the File menu that appears when you enter Word from 
ChartScript, with a few differences. The additional options 
on this menu are More Fields, Expand Insert, Move to 
Next Jump Code, Spell Check Document, Abbreviations, 
Clear Document Text, Provider Message, Interface 
Record, and Edit Document in MS Word.  

 

 

 

 

 

 

Quitting ChartScript Express 
♦ To quit ChartScript Express 

1. From the Options menu, select 
ChartScript Express. A 
message window appears 
letting you know that 
ChartScript Express is now 
inactivated. 

2. Select OK. You now can work in 
standard ChartScript mode. 
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Using In-House Backup, you can continue to transcribe documents when the network or 
ChartScript is unavailable. In-House Backup also works with VoiceScript. For instructions 
on selecting VoiceScript settings, see Appendix F, “VoiceScript Settings.” 

Refreshing In-House Backup Files 
Be sure to keep your local In-House Backup files current so that the latest provider list, 
text inserts, abbreviations, and document types are available, if needed. 

♦ To refresh In-House Backup files 

1. From the ChartScript Import menu, select Install/Refresh In-House Backup Files. 
2. On the Install/Refresh In-

House Backup Files window, 
verify the path of your local 
files. The default location is 
C:\Ihbkup. Also, select  
adjacent to the Personal Abbreviations/Text Insert Files to Include field. 

3. On the dialog box that appears, select the initials of 
the users whose expanders should be copied down 
to the workstation.  

4. Select OK twice. The In-House Backup files are 
copied to the workstation. 

5. Select OK again to clear the message prompt. 
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Starting In-House Backup 
♦ To start In-House Backup 

1. If you do not see an In-House Backup icon on your desktop, from the Windows 
Start menu, select Programs"SoftMed for Windows"In-House Backup. 

2. On the In-House Backup 
window, select your user ID and 
a document type. 

 
 
 
 
 
3. Select OK. The 

In-House 
Backup main 
window 
appears. 
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Creating New Documents 
♦ To create a new In-House Backup document 

1. On the In-House Backup main 
window, type demographic 
information for the 
document. You must enter 
information into all fields 
that are required in 
ChartScript. Fill in as many of 
the fields as you can to assist 
ChartScript in importing the 
document later. 
Note: At a minimum, you 
must indicate the dictating 
physician and one of the 
following: medical record number, billing number, order number, EPI number, or 
job/tape ID if your facility uses DDSI. 

2. Select Document to open Microsoft 
Word and transcribe the document. 
An In-House Backup document does 
not include header information, 
footer information, or signature 
lines. These sections are added to the 
document when it is imported into 
ChartScript. 
While editing an In-House Backup 
document, the following ChartScript 
features are available: 

# Edit CC List (CTRL+E). 
# Insert Address (CTRL+R). 
# Change Document Type (on the File menu). 
# Text Inserts (CTRL+N) and Abbreviations (CTRL+A). 
# Document Status (CTRL+O). 
# Creating or Viewing an ESA Message (CTRL+L). 
# Edit Demographics 

Each of these features works in the same manner in both ChartScript and In-
House Backup and is discussed in Chapter 4, “Creating a Document.”  

3. When you finish transcribing the document, press CTRL+S to save the document, 
or on the ChartScript toolbar in Word, select Save.  
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4. On the dialog box that appears, in 
the Copies field, type the total 
number of providers receiving extra 
copies (not ProviderID carbon 
copies). For more information, see 
the “Adding Extra Copy Providers” 
section below. 

5. Confirm that the Batch Print check 
box is selected so that the document will be batch printed after it is imported 
into ChartScript. Select OK. 

Adding Extra Copy Providers  
You can print extra copies of an In-House Backup document for providers who are not in 
the ProviderID database in In-House Backup. If a provider or entity is not found, they 
cannot be added to the CC list using the Edit CC List (CTRL+E) function. SoftMed 
recommends the following procedure for indicating non-ProviderID copy recipients. For 
this example, assume that John Smith, M.D. and Tom Johnson, D.O. are consulting 
physicians not in ProviderID and need copies of an In-House Backup document. 

♦ To add extra copy providers 

1. Transcribe the document as described in the “Creating New Documents” section 
on page 10-3. 

2. Before saving the document, go to the end of the body of the document. On a 
blank line, type {SEC XCOPY} to indicate to ChartScript that this section includes 
the names of non-ProviderID copy recipients. 

3. On the next line, press TAB, and then type an asterisk and the provider/entity's 
name. 

4. On the next line, type {END}.  
Using the example described above, 
the resulting section would appear as 
at right. 

5. After the document has been 
completed, select Save (CTRL+S). 

 

 

 

 

 

6. In the Copies field, type the total number of 
providers receiving extra copies. Remember 
to indicate one copy for each provider/entity 
that is added to the XCOPY section. In this 
example, two non-ProviderID copy recipients 
have been added, so the number of copies 
should be set to two. Select OK. 
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Editing Documents 
You can edit In-House Backup documents that you have not yet imported to ChartScript. 

♦ To edit an In-House Backup document 

1. On the In-House Backup main window, select Doc List.  
2. On the Saved Documents 

window, select a document 
from the list and select OK. 
The document opens in Word. 

 
 
 

Changing the Document Type 
Use the Change Document Type option if, after you have started a document, you realize 
that the document type is incorrect. 

♦ To change the document type by copying text 

1. Select any text in the body of the document that you want to keep. 
2. From the File menu in Word, select Document Type. 
3. On the Change Document Type 

dialog box, in the Document Type 
field, select a new document type. 
Select OK. 

4. On the In-House Backup main 
window, verify the demographic 
information and select Document. In-House Backup creates a new document in 
Word.  

5. Read the Change Document 
Type-Finished dialog box and 
select OK. 

6. In the new document, place the 
cursor where you want to place 
the text from the first document 
and, from the File menu, select 
Paste: Document Type Text. 
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♦ To change the Document Type without copying text 

1. From the File menu in Word, select Document Type. 
2. On the dialog box that 

appears, select Yes. 
3. On the Change Document 

Type dialog box, in the 
Document Type field, select a 
new document type and 
select OK. 

4. On the Add a Document window, verify the demographic information and select 
Document. In-House Backup creates a new document in Word. 

5. If you attempt to paste text 
into the new document, the 
dialog box at right appears. 
Select OK. 

 

Editing Demographics in In-House Backup 
You can edit existing document demographic information and save the changes without 
changing the text in Word. 

♦ To change document demographic information 

1. On the In-House Backup main window, select Doc List. 
2. On the Saved Documents window, select a document. Select OK. The document’s 

demographics appear on the In-House Backup main window. 
3. Change the appropriate demographic information. If the demographic field that 

you want to change does not appear on this window, select More Fields to 
display the remaining demographic fields. 

4. Select Save to save your changes and close the window. 

Retrieving Interrupted Documents in In-House 
Backup 
If Word unexpectedly shuts down while you are transcribing a document, you can 
retrieve a backup copy. The procedures for retrieving interrupted documents and 
Lastsave.rtf files are the same for In-House Backup as they are for ChartScript. For 
instructions on retrieving interrupted documents using the Word AutoRecover feature, 
see the “Retrieving Interrupted Documents” section on page 7-1. For instructions on 
retrieving the Lastsave.rtf file, see the “Retrieving Lastsave.rtf” section on page 7-2. 
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Moving In-House Backup Documents to the 
Network 
When ChartScript or the network becomes available, move the In-House Backup 
documents from your local drive to the network. 

♦ To move In-House Backup documents 

1. On the ChartScript main window, from the Import menu, select Move In-House 
Backup Documents from Local PC to Network. 

2. At the message prompt, select OK. 
When the ChartScript administrator runs Automatic Document Import, the documents 
will import into ChartScript. 
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With WebLinc Script, you can transcribe documents remotely using all of the capabilities 
of ChartScript that you would normally have at your facility. Since connectivity occurs 
over the Internet, this is a fast, convenient way to use ChartScript without having to be 
in the facility itself. For more information, see the WebLinc Getting Started Guide. 

Starting WebLinc Script 
The first time that you start WebLinc Script, you must create a central user name and 
password and then link your central user name to your ChartScript user name. 

♦ To start WebLinc script for the first time 

1. Start WebLinc Script. The WebLinc Script client attempts to update any out-of-
date files on the workstation. The WebLinc Script client then attempts to connect 
to the WebLinc Server. 

2. On the Login window, select Create Login ID. 
3. On the New Central Login ID window, 

type a new Login ID, your First Name, 
and your Last Name. Type a password 
in the Password and Confirm 
Password fields. Select OK. 
Note: Use this Login ID and Password 
the next time that you start WebLinc 
Script. 

4. On the ChartScript Login window, type 
your ChartScript password and then 
select OK. 
Note: If your SoftMed system has been 
upgraded, your old password should 
still be active. If you are a new user, 
your ChartScript administrator must tell you your password. 
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5. On the Link to Central User 
Table dialog box, confirm that 
you are linking to the correct 
ChartScript user and select 
Yes. If you are not linking to 
the correct user, select No and 
try entering your ChartScript password again. 

♦ To start WebLinc Script after the first time 

1. Start WebLinc Script. The WebLinc Script client attempts to update any out-of-
date files on the workstation. The WebLinc Script client then attempts to connect 
to the WebLinc Server.  

2. On the Login window, in the User ID and Password fields, type the login ID and 
password that you created in Step 3 on the previous page. Select OK, and the 
Search for and Add Documents window appears. 

WebLinc Script Menu 

Tools Menu 
Use the Tools menu to view your 
statistics (by selecting Users 
Documents), to set your VoiceScript 
settings, to refresh offline files, and to 
move offline documents from your local 
workstation to the server (by selecting 
Move Off-Line Documents from Local 
PC to Server). See the WebLinc Script Offline chapter for more information on these two 
menu options. You also can information about WebLinc Script by selecting About 
WebLinc Script. 

Quitting WebLinc Script 
♦ To quit WebLinc Script 

1. On the Search for and Add Documents window or the Search for and Edit 
Documents window, select Cancel. 

2. On the dialog box that appears, 
select OK to exit from the WebLinc 
Script session. 
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Adding a New Document in WebLinc Script 
The process of adding a document in WebLinc Script is the same as described in Chapter 
4 of this guide. 

Note: When editing a document in WebLinc Script, there is not an option to search using 
Report Generator on the Search for and Edit window.  

Considerations When Using VoiceScript 

After selecting a job from the Jobs Assigned to You window, if the data stream fails to 
completely load, WebLinc automatically attempts to reload the voice file. Reloading is 
controlled by a timeout period defined in your VoiceScript Settings (see Appendix F). 

Each time a voice job is received at your workstation, the 
internal counter starts. You should begin playback as soon as 
the blue progress bar indicates that at least 30 seconds of the 
voice job has been streamed. 

If the system detects that it has not received any data within 
the timeout period set on the workstation, the player is closed, and the stream is 
cancelled and automatically restarted. The portion of the voice job already received by 
your workstation is retained, and streaming restarts from that point forward. The player 
reappears on your workstation. If you had been listening to the job at the time that the 
player closed, you can return to your previous position by pressing Alt + ]. 

Streaming makes up to three attempts to deliver the complete voice job. If streaming 
fails for the third time, the player closes and an error message is displayed. The error 
message instructs you to turn off streaming and load the job in its entirety.  

Note: WebLinc provides an option to completely disable streaming and instead 
download a voice file in its entirety. This option is controlled by the Enable Digital 
Streaming parameter. From the Tools menu, select VoiceScript Settings (see Appendix 
F for details about the settings). The default setting is on. SoftMed recommends turning 
this off only as a last resort. If this parameter is turned off to load a voice job, SoftMed 
recommends that once that job is completed, you turn this parameter back on prior to 
accessing another job. 

When the player is waiting for parts of the voice job to stream to the workstation, the 
blue progress bar momentarily changes from blue to yellow. When it detects additional 
parts of the job being streamed, the progress bar changes back to blue. When the player 
detects that the entire voice file has been successfully streamed, the progress bar 
remains blue and fills the width of the lower bar. 

Note: A yellow progress bar does not indicate a time out or that the stream is going to be 
restarted. It simply indicates a momentary pause in the normal streaming process. 
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Interruptions in Connectivity While Adding a New Document 
There may be instances when 
WebLinc connectivity is interrupted 
while creating a new document. 
When this occurs, an attempt is made 
to re-establish the connection. If the 
connection is re-established, you are able to continue transcribing and will notice no 
changes. Five attempts at re-connecting will be made. If after five attempts the 
connection has not been re-established, the message above will appear.  

Select Retry if you would like to continue attempting to reconnect, or Cancel if you 
would like to cancel and exit WebLinc Script. If you select Cancel, see the LASTSAVE 
instructions in the “Retrieving an Interrupted Document in WebLinc Script” section on 
page 11-4 to retrieve your interrupted document. 

If while you are using WebLinc Script you would like to check whether 
you are connected to the server, there is a notification area in the task 
bar, shown at right, that will alert you to connection status. If the icon is 
blue, you are connected. If the icon is red, you are not. 

Retrieving an Interrupted Document in WebLinc 
Script 
In WebLinc Script there are several methods that can be used to retrieve a document. 

! Microsoft Word AutoRecover feature: If Microsoft Word shuts down unexpectedly 
while transcribing a document, you can retrieve a backup copy. This can be done 
using the instructions outlined on page  7-1of this guide. 

! WebLinc Document Recovery 
feature: If WebLinc Script detects 
a loss of connection between the 
user and the WebLinc server, the 
message at right appears. 

 

! ChartScript LastSave feature: If 
there is a problem during the save 
process, the message at right 
appears: 

♦ To use LastSave 

1. Browse to C:\softweb\scr\tmpfiles and open the file LASTSAVE.RTF. 
2. Select the body of the text and copy it (CTRL+C). 
3. Note: Do not copy headers, footers, signature lines, and CC lists; only the body of 

the document. 
4. From the File menu, select Exit to exit Microsoft Word. You do not need to save 

the document; however, you may choose to do so as an additional safety 
measure. 
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5. Start WebLinc Script. 
6. Proceed as if you were creating a new document. 

Note: The demographics window of an auto-saved document is not recoverable 
and must be recreated manually. 

7. On the Add a Document window, recreate the demographics window for the 
document. Select Document. 

8. In ChartScript Word, place your cursor in the proper location and press CTRL+V 
to paste the text into the document. 

9. Note: The CC List of an auto-saved document is not recoverable and must be 
recreated manually using Edit CC List. 

10. Proceed with completing and saving the document. 

♦ To use WebLinc document recovery if the document is still on the monitor 

1. Select the body of the text and copy it (CTRL+C). 
2. Note: Do not copy headers, footers, signature lines, and CC lists; only the body of 

the document. 
3. From the File menu, select Exit to exit Microsoft Word. You do not need to save 

the document; however, you may choose to do so as an additional safety 
measure. 

4. Start WebLinc Script. 
5. Proceed as if you were creating a new document. 

Note: The demographics window of an auto-saved document is not recoverable 
and must be recreated manually. 

6. On the Add a Document window, recreate the demographics window for the 
document. Select Document. 

7. In ChartScript Word, place your cursor in the proper location and press CTRL+V 
to paste the text into the document. 
Note: The CC List of an auto-saved document is not recoverable and must be 
recreated manually using Edit CC List. 

8. Proceed with completing and saving the document. 

♦ To use WebLinc document recovery if the document has disappeared from the 
monitor 

1. Browse to c:\softweb\scr\tmpfile and open the file u1-1.swd in Microsoft Word. 
2. Select the body of the text and copy (CTRL+C). Note: Do not copy headers, 

footers, signature lines, and CC lists; only the body of the document. 
3. From the File menu, select Exit to exit Microsoft Word. You do not need to save 

the document; however, you may choose to do so as an additional safety 
measure. 

4. Start WebLinc Script. Proceed as if you were creating a new document. 
Note: The demographics window of an auto-saved document is not recoverable 
and must be recreated manually. 

6. On the Add a Document window, recreate the demographics window for the 
document. Select Document. 
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7. In ChartScript Word, place your cursor in the proper location and press CTRL+V 
to paste the text into the document. 
Note: The CC List of an auto-saved document is not recoverable and must be 
recreated manually using Edit CC List. 

8. Proceed with completing and saving the document. 

Reporting Productivity 
With the User’s Documents report, you can view and print a report of your productivity 
over a range of time. This report includes statistics only for the user logged into WebLinc 
Script. 

♦ To generate the report 

1. From the Tools menu, select User’s Documents. 
2. Type a start date for the reporting period. 
3. Type an end date for the reporting period. Select OK. 
4. On the Printer Setup window, do one of the following 
# Select Print to print the report to the selected printer (if you have a printer 

attached to your workstation). 
# Select Print Preview to view the report on your monitor. 

5. Select Close to exit the report. 
Note: Your statistics are available for 13 months. 
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WebLinc Script Offline is a downtime productivity solution for users of WebLinc Script. It 
is a variant of In-House Backup that can be used to transcribe remotely when 
ChartScript, the facility’s network, or your Internet connection is unavailable. Since most 
of the functions in WebLinc Script Offline work in the same manner that they do in In-
House Backup, refer to the “Using In-House Backup” chapter earlier in this guide for 
information on functions not included in this chapter, such as creating new documents, 
editing documents, and so on. 

Two of the menu choices on the WebLinc Script menu apply directly to WebLinc Script 
Offline. They are Refresh Off-Line Files and Move Off-Line Documents from Local PC 
to Server.   

Refresh Off-Line Files refreshes the local program files. When you select Refresh Off-
Line Files, all applicable WebLinc Script Offline files are refreshed on your workstation.  

Refreshing WebLinc Script Offline Files 
Be sure to keep your local WebLinc Script Offline files current so that the latest provider 
list, text inserts, abbreviations, and document types are available, if needed. 

♦ To refresh WebLinc Script Offline files 

1. From the WebLinc Script Tools menu, select Refresh Off-Line Files. 
2. Select OK to clear the 

message prompt. 
Note: If the NORMALS.SCR file needs 
to be refreshed and the file is larger 
than 3MB, you will receive a message 
telling you how big the file is on your host system so that you will have some sense of 
how long the download might take, given your connection speed. If you decide not to 
refresh your local copy and you don’t have a copy yet, a blank one is written to the 
WebLinc Script Offline subdirectory. If the NORMALS.SCR file is less than 3MB, the file is 
automatically downloaded. 
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Moving WebLinc Script Offline Documents to the 
Network 
When ChartScript or the network becomes available, move the WebLinc Script Offline 
documents from your local drive to the network. 

♦ To move WebLinc Script Offline documents to the network 

1. From WebLinc Script Tools menu, select Move Off-Line Documents from Local 
PC to Server. 

2. At the message prompt, select OK. 
When the ChartScript administrator runs Automatic Document Import, the documents 
import to ChartScript. 
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The ChartScript importing process enables facilities to receive document files from an 
outside source and import them into ChartScript so that they are available in the 
database along with documents that were typed directly into ChartScript. 

ChartScript can accept documents that were transcribed using HomeScript and In-
House Backup, as well as documents that were transcribed using other word processing 
programs, as long as the documents are formatted using structured, unstructured, or 
XML format. This chapter discusses how to import documents into ChartScript and 
provides some basic troubleshooting techniques. 

Consult the ChartScript Importing Guide or the “Document Importing” chapter of the 
ChartScript Management Guide for more information. 

Importing Processes 
Two types of importing are available in ChartScript: automatic importing and single 
document importing. The automatic importing process can be run as a continuous 
process, or it can be run as needed. This section describes the importing processes and 
how to perform them. 

Non-Continuous Automatic Importing 
The automatic importing process is called “automatic” because ChartScript retrieves and 
imports each document without manual intervention after the process has been started. 
Non-continuous automatic importing requires a user to initiate the process in 
ChartScript. 

♦ To perform the automatic import process 

1. From the ChartScript toolbar, select Import.  
2. On the message box that 

appears, indicating how many 
document files there are to 
import, select Yes.  
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3. On the message box that 
appears, asking whether you 
want to process files 
continuously, select No. See 
the following section on 
“Continuous Automatic Importing” for more information on this step.  

4. The automatic importing 
process starts. 

5. Documents that meet the 
requirements for automatic 
importing are merged into 
ChartScript. Documents that 
do not meet the requirements 
are moved to the Impsingl 
directory and must be imported using the single document importing process. 

6. When the import process is 
complete, print the Import 
Problems report before 
closing. If you do not print 
before closing, the 
information can be viewed 
later in the Auto Import Error 
Log. 

 
 
 
 
 
 

Continuous Automatic Importing 
ChartScript is capable of importing documents continuously rather than waiting for 
someone to initiate a non-continuous automatic import. This continuous process is 
advantageous because documents are detected and imported into ChartScript as soon as 
they are received from the external transcriptionists. 

Note: The continuous automatic importing process must be run by itself on a dedicated 
workstation. 

♦ To start continuous automatic importing 

1. From the ChartScript toolbar, select Import. A message box appears telling you 
how many document files there are to import. 

2. Select Yes. A message box appears asking if you want to process files 
continuously. 

3. Select Yes. ChartScript attempts to import any documents that are waiting to be 
imported. Documents that meet the requirements for automatic importing are 
merged into ChartScript. Documents that do not meet the requirements are 
moved to the Impsingl directory and must be imported using the single 
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document importing process. After the automatic importing process is 
completed, ChartScript continues to wait for any new documents so that they 
can be imported as soon as they arrive. 

Note: If no documents are 
waiting to be imported, the 
message at right appears. 

 

♦  To stop continuous automatic importing 

1. Select Cancel.  
2. The message at right appears. 
 
 
 
 
 
3. Select Yes. Continuous import stops, 

and you must select Import from the 
ChartScript toolbar to restart 
importing. 

 
 
 

Single-Document Importing 
The documents that do not import successfully during an automatic document import 
session are placed in the Impsingl directory. These documents must be imported 
individually so that the information on the document can be verified. Often documents 
must be imported individually because important information is missing or incorrect. 
Use the Auto-Import Error Log to assist with rectifying the issues associated with each 
document that requires manual intervention. See the “Auto-Import Error Log” section 
later in this chapter for more information. 

♦ To verify and import single documents 

1. From the ChartScript toolbar, select Add. 
2. On the Search for and Add 

Documents window, select 
Import (F11). 



 

                   Chapter 13: Document Importing  13-4 

3. On the Import Document 
window, select the document 
file name that you want to 
import and then select OK.  

 
 
 
 
 
 
 
 

The contents of the document 
file are displayed at the 
bottom of the window.  

Note: If the document fails to 
import, select Reason for 
Failure to view the reason 
why it failed. Then you can try 
to import the document again 
after correcting the error. 

 

 

 

 

 

 

 

4. Facilities that use DDSI: Select DDSI. On the Search Dictation Interface window, 
search for the job number provided in the document displayed at the bottom of 
the window.  
If the job number is found, 
ChartScript retrieves the 
dictation record and then 
automatically searches the 
patient interface records 
using the patient identifier 
specified in the dictation 
record (usually the medical 
record number or billing 
number). Three possible 
situations may result: 

# If ChartScript finds exactly one matching interface record, it automatically 
selects the record and displays to the Add a Document window.  
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Note: If the dictation record does not link to a ChartScript document type, 
the Document Type dialog box appears. Select the document type that you 
are importing and select OK. The Add a Document window appears. 

# If multiple matching records are found, they appear in the Patient Interface 
Records found section at the bottom of the window. Select the correct 
patient interface record and then choose Select. The Add a Document 
window appears. 
Note: If the dictation record does not link to a ChartScript document type, 
the Document Type dialog box appears. Select the document type that you 
are importing and select OK. The Add a Document window appears. 

# If the dictation search does not yield a list of patient interface records, or if 
your facility does not use DDSI, proceed to Step 5. 

5. Facilities that do not use 
DDSI: Using the search 
window, search for the 
patient using the medical 
record number, patient name, 
or other information provided 
in the document displayed at 
the bottom of the window.  
Two possible situations may 
result: 

# If ChartScript finds one or 
more matching interface 
records, they appear in 
the Patient Interface Records found section at the bottom of the window. 
Select the correct patient interface record and then choose Select. The Add a 
Document window 
appears. 
Note: If the document file 
does not include a 
document type, or if the 
document type is invalid, 
the Document Type dialog 
box appears. Select the 
document type that you 
are importing and select 
OK. The Add a Document 
window appears. 

# If the patient search does 
not yield a list of patient 
interface records, or if your facility does not use patient interface records, go 
to Step 6. 
Note: If you do not find a matching patient interface record using one field, 
such as the medical record number, SoftMed recommends trying several 
different fields, including the patient name and billing number, to search for 
a match before proceeding to the next step. 
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6. Facilities with no Interface Data: If your search via the patient and/or 
dictation interfaces did not yield a matching patient interface record, select Add. 
On the Document Type dialog box, select the document type that you are 
importing and select OK.  

7. On the Add a Document 
window, verify the 
information in each data field 
and select Document. 
Note: To view the contents of 
the document file, select 
View (F2) on the Add a 
Document window. 

 

 

8. On the Transcriptionist to get 
keystroke credit dialog box, 
verify the transcriptionist’s 
initials and select OK. 

 
 
 
9. ChartScript opens the 

document in Word. Do one of 
the following: 
# Select Save (CTRL+S) to 

save the document and 
print it later as part of a 
batch. 

# Select Print (CTRL+P) to 
save the document and 
print it now.  

 

 

Troubleshooting Problems With Imported 
Documents 

Auto-Import Error Log 
The automatic importing process generates an error log that tracks the number of 
documents that imported successfully, as well as a list of the documents that did not 
import and require manual intervention. This log, called the Auto-Import Error Log, 
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provides a detailed list of the problems encountered for each document that did not 
import. It is very helpful in determining how to import each document individually. 

♦ To view and print the Auto-Import Error Log 

1. On the ChartScript main window, from the Reports menu, select Auto-Import 
Error Log.  

2. On the Automatic Document 
Import Error Log window, 

select  to print the log. 

 
 
 
 
 
 
 
 
 
  
3. On the Printer Setup 

window, in the Printer Name 
field, select a printer. Select 
Print.  

Note: SoftMed recommends that you 
develop a policy for rectifying the 
problems found in the Auto-Import 
Error Log using Single Document 
Importing, and a policy for deleting 
the old data in the Auto-Import Error 
Log occasionally by selecting Clear 
Log. After the Auto-Import Error Log 
is cleared, it cannot be retrieved. 

Resolving Importing Problems 
See the “Error Glossary” and “Formatting Issues” sections in the “Document Importing” 
chapter of the ChartScript Management Guide for specific troubleshooting 
recommendations. 
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In addition to being a document creation program, ChartScript was designed to manage 
the document distribution process for your facility. Individual documents can be printed 
using the stat printing and reprinting processes that are described in Chapter 6. This 
chapter discusses other document distribution functions that you may need to use. 

Batch Printing 
Based on your facility’s distribution needs, ChartScript uses batch printing to organize 
and distribute the documents that it produces efficiently. Batch printing enables 
ChartScript to gather groups of documents that have the same priority and distribution 
schedule and generate them at the same time.  

After a transcriptionist types a document, it can be saved and flagged for batch printing 
later. When ChartScript processes a batch print job, only documents that have been 
marked with a “batch flag” are considered to be part of the print job. In addition to 
searching for a batch flag, a facility can also select other fields to define the grouping 
and sorting of each batch, such as document type, patient type, patient name, and so on. 

The batch print flags associated with 
each document can be viewed in the 
BP (Batch Pending) column of the 
ChartScript Documents Found pane of 
the Search for and Edit Documents 
window. 

The following is a summary of the 
available batch print flags. 

! O: The originals and any extra 
copies that are indicated are 
flagged for batch printing. This 
flag indicates that either the 
document has no carbon copies or that the carbon copies are not flagged to batch 
print. 

! C: The carbon copies that were indicated are flagged for batch printing. This flag 
indicates that either the originals and extra copies have already been printed or that 
they are not flagged to batch print. 

CHAPTER 14 

  

Batch Printing and 
ChartPrint 
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! A: The originals, any extra copies, and the carbon copies are all flagged for batch 
printing. Often this flag indicates that the document has recently been transcribed 
or edited and is awaiting the next available batch print job so that it can be printed. 

! Blank: None of the copies associated with the document are flagged to batch print. 
This flag indicates that either the document has never been flagged for batch 
printing or that all copies have been printed in previous batches. 

Running Manual Batch Print Jobs 
Batch print jobs can be run on demand at any time throughout the day. Manual batch 
printing is useful for situations in which the schedule for document distribution can 
vary greatly from day to day, or for occasional situations in which a batch that is 
typically run using an automatic ChartPrint schedule needs to be run outside of its 
regular schedule. Manual batch printing gives the users who handle document 
distribution more control and flexibility. 

♦ To run a batch print job 

1. On the ChartScript main window, from the toolbar, select Batch Prt. 
2. On the Batch Print window, do one of the following: 
# If you are creating a new batch print job, follow Steps 2-7 in the “Creating a 

Batch Print Job” section of the “Printing Functions” chapter of the 
ChartScript Management Guide. 

# If you would like to run 
an existing batch print 
job, select List Saved 
Reports. Select the batch 
print job that you want to 
run and select OK. 

3. Select Print.  
 
4. On the Batch Print-Document 

Print Configuration window, 
in the What to Print section, 
select whether to print 
Originals and Extra Copies 
only or to print Originals, Extra 
Copies, and CCs.  

5. In the Print Rule for 
Originals/Extra Copies section, 
select the print rule that you 
want to use. 

6. If you chose to print Originals, Extra Copies, and CCs, in the Print Rule For CCs 
(Print Method) section, select the print rule that you want to use. In the Sort CCs 
by section, select sorting by provider name or provider number. 

7. If you chose to print Originals, Extra Copies, and CCs, in the Envelope Print Rule 
for CCs section, select an envelope rule, if necessary. 
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8. In the Process Via section, select one of the three options: 
# Select Locally if you would like to bypass ChartPrint and process the batch 

print job on your workstation. This option requires that the printer(s) being 
used be installed on your workstation. 

# Select ChartPrint Now if you want to send the batch print request to 
ChartPrint to be processed as soon as possible. 

# Select ChartPrint Later at ___ if you would like to send the batch print 
request to ChartPrint to be processed at a later time. This option allows you 
to indicate the time that you want the batch print to be run by ChartPrint. 

9. Select Display Estimate First if you want to see how many documents will be 
generated by the batch print that you are running. 

10. Select Print to process the batch print job. If you elected to see an estimate first, 
the Batch Print Estimate window appears. Select Close when you are finished 
reading the estimate to continue the batch print. Select Yes on the message box 
that appears. 

ChartPrint 
ChartPrint is a program that runs on a dedicated PC on your network and enables you to 
track the status of print jobs that ChartScript users initiate from their workstations. 
ChartPrint can process “on demand” printing requests as they are received. In addition, it 
can also automatically run any scheduled print jobs that are processed on a regular 
basis. 

ChartPrint Processor 
The ChartPrint Processor must be running on a workstation before it can process any 
print jobs. This means that any type of print job that is submitted for immediate 
processing, as well as any jobs that are scheduled to print at specific times, will be held 
in the ChartPrint queue until the processor is started. 

Starting the ChartPrint Processor 

♦ To start the ChartPrint processor 

! On the ChartPrint workstation, double-click the ChartPrint desktop icon. 
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The ChartPrint Job Processor window 
appears, and the ChartPrint processor 
begins processing immediately. 

The ChartPrint Print Job Processor 
window provides the following 
information about ChartPrint 
activities: 

! Title Bar. Indicates the processor 
number and the types of print 
jobs that the processor will 
handle. 

! Status. Shows the time that this 
processor last looked for print jobs 
to be processed. Every ten seconds 
ChartPrint updates the status of 
the print jobs and looks for new or scheduled jobs to be processed.  

! Total Jobs Queued. The total number of all jobs that are queued and waiting to be 
processed by the ChartPrint processor. 

! Stat. The number of jobs queued and waiting to be processed that were submitted 
from within individual documents as stat prints. 

! Reprint. The number of queued jobs that were submitted through reprinting an 
individual document. 

! Batch. The total number of batch print jobs queued, with subtotals for each of the 
various types of batch print jobs: Ready to Print (manually submitted jobs to be 
printed as soon as possible), Deferred (manually submitted but scheduled for a later 
time), and Scheduled (auto-scheduled at regular day and time intervals). 

! Report Generator. The total number of report generator jobs queued, with subtotals 
for each of the various types of report generator jobs: Ready to Print (manually 
submitted jobs to be printed as soon as possible), Deferred (manually submitted but 
scheduled for a later time), and Scheduled (auto-scheduled at regular day and time 
intervals). 

! Jobs in Error. A count of all print jobs that are currently in error. This number 
appears on the window in red, so that it can be readily noticed by anyone looking at 
the ChartPrint Processor or Monitor. 

! Processors. Information about each ChartPrint processor that is currently running. 
For each running processor, it displays the processor ID (a number from 1 to 10), the 
type of jobs that it will print (All Jobs or Only Stat), and its status (Idle, Printing a 
Batch Job, Printing a Stat/Reprint Job, or Suspended). If no processors are running, no 
entries are displayed. 

! Processed this Session. Indicates the total number of print jobs that have been 
processed by this ChartPrint Processor since it was most recently started. This 
section also provides a breakdown that describes how many of the completed jobs 
were stat, reprint, batch, or report generator, as well as how many print jobs did not 
process due to errors. 

! Minutes Since Last Job. Displays the number of minutes since ChartScript has 
processed a job. 
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Closing the ChartPrint Processor 
You can close the ChartPrint processor if needed; however, print jobs sent to ChartPrint 
will not be processed until you restart the ChartPrint processor. 

♦ To close the ChartPrint processor 

1. On the ChartPrint Print Job Processor window, select Close. 
2. On the dialog box that appears, select 

Yes to stop the ChartPrint processor. 

ChartPrint Monitor 
ChartPrint Monitor is available in ChartScript 
so that users can view and manage the print 
jobs that they personally have submitted to 
ChartPrint from their own workstations. Someone in your facility should review the 
ChartPrint Monitor window on a regular basis to ensure that jobs are printing properly. 

♦ To start the ChartPrint monitor 

! On the ChartScript main window, from the Reports menu, select ChartPrint 
Monitor. 

The ChartPrint Monitor displays totals for all 
ChartPrint Processors that are currently running. 
The information provided by ChartPrint Monitor is 
the same as the ChartPrint Processor, except for 
the Processors section. For each running processor, 
ChartPrint Monitor displays the processor ID (a 
number from 1 to 10), the type of jobs it will print 
(All Jobs or Only Stat), and its status (Idle, Printing 
a Batch Job, Printing a Stat/Reprint Job, or 
Suspended). If no processors are running, no 
entries are displayed. 

At the bottom of the ChartPrint Monitor window 
are four buttons. The List Jobs and Batch Print 
Results buttons are unique to the ChartPrint 
Monitor window. 

List Jobs 

Select List Jobs to view information 
on pending print jobs. Following are 
descriptions of the columns on the 
ChartPrint Monitor – Jobs window. 

! Report ID. For batch print, all 
documents, or report generator 
jobs, this column displays the 
name of the saved report criteria 
used to select the documents that 
are to be printed. This column is empty for stat and reprint jobs, or for “ad hoc” batch, 
all documents, or report generator jobs that are not based upon saved report criteria. 



 

                   Chapter 14: Batch Printing and ChartPrint  14-6 

! Job Type. Lists the type of job to be processed. 
! Status. Indicates which print jobs are currently being processed and whether any 

print jobs have stopped due to an error. If this column is empty, the job is not 
currently being processed by any of the ChartPrint processors, and no errors have 
occurred. 

! User. The initials of the user who submitted the print job to the ChartPrint 
processor.  
Note: Print jobs without initials were submitted to the ChartPrint processor by a 
SoftMed employee who logged onto ChartScript using the SoftMed password. 
SoftMed employees who are assisting clients in setting up or testing the ChartPrint 
processor almost always log on using the SoftMed password. 

! Next Run. Indicates the date and time that the queued job is set to print. Stat prints 
and reprints always say ASAP. “Ad hoc” batch, all documents, and report generator 
jobs also will indicate ASAP in this column. Deferred and scheduled batch, all 
documents, and report generator jobs indicate the date and time when the job is 
scheduled to run.  
Note: If all ChartPrint processors were off when scheduled jobs were due to be 
processed, this column shows the time that the job should have been processed. 
These jobs will be processed in order as soon as a ChartPrint processor is started. 

! Submitted. Indicates the date and time that a job was submitted to ChartPrint or 
when the auto-schedule was created. The ChartPrint processor uses this information 
to prioritize ASAP print jobs, as well as any scheduled batch, all documents, or report 
generator requests that are scheduled to print at the same time. ChartPrint decides 
which jobs to process first based on the date and time submitted, with the oldest 
jobs having highest priority. 

Details 

You can view details about a specific print job by selecting the Details button on the 
ChartPrint Monitor – Jobs window.  

The information shown on the Job 
Details window differs depending on 
the type of print job and whether an 
error has occurred. Typical 
information displayed for print jobs 
includes information identifying the 
individual document or saved report 
criteria, the type(s) of copies being 
printed, and which print rules are 
being used. If there is an error, the 
window displays information about 
the error, including which document 
was printing when the error occurred. 
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Batch Print Results 

To see the results of all ChartPrint 
batch and all documents print jobs, 
on the ChartPrint Monitor window, 
select Batch Print Results. The 
window at right appears. 

This window includes a title 
indicating the date and time that the 
print job was processed and the 
report ID used to select the 
documents that were printed. 
Because this report is generated after 
printing, rather than before, in 
addition to indicating the total 
number of documents that met the 
selection criteria and how many were 
not ready, this report also indicates how the documents were distributed—via printing, 
fax, or e-mail. Remote and UNC distribution methods are included in the Printed column. 

Troubleshooting Printing and Distribution 
Problems 
See the “Printing Functions” chapter of the ChartScript Management Guide for further 
information on batch printing. See the “ChartPrint” chapter of the ChartScript 
Management Guide for further information about ChartPrint, including an error 
glossary. See the “ChartFax/E-Mail Server” section in the “Auxiliary Products” chapter of 
the ChartScript Management Guide for further information on carbon copy distribution 
via fax and e-mail, including an error glossary. 
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This section provides a brief overview of the basic Microsoft Windows skills required to 
use a SoftMed program. For more details on using Windows, refer to Microsoft Windows  
Step by Step for your operating system, a comprehensive book and disk tutorial from 
Microsoft Press. 

This chapter explains how to 

! Move between a SoftMed program and other programs. 
! Use commands in menus and toolbars. 
! Move between fields and tabs on a SoftMed program window. 
! Use fields on SoftMed windows to enter data. 
! Use lists on SoftMed windows to enter data. 
! Display ChartScript help. 

For each topic, this chapter describes how to use the mouse and the keyboard to work 
with SoftMed programs. 

Switching Between Running Programs 
In Windows, you can switch between 
programs that are running. You do not need to close a program to work with another 
program. The names of all running programs appear on taskbar buttons at the bottom of 
the desktop. 

♦ To switch between running programs by using the keyboard 

1. Press and hold ALT. 
2. Press tab to display a window showing icons for running programs. 
3. Press tab repeatedly to cycle through running programs. 
4. When the name of the program that you want to switch to appears, release the 

keys. 

♦ To switch between running programs by using the mouse 

! On the taskbar, click the button for the program to which you want to switch. 

APPENDIX A 

 

Microsoft Windows Basics



 

                   Appendix A: Microsoft Windows Basics  A-2 

Using Menu Commands 
The menu bar along the top of a 
SoftMed window lists the names of the command menus. 

When you open a menu, a list of commands appears. You 
can use either the mouse or the keyboard to select menu 
commands. 

Note: Dimmed options are unavailable. 

♦ To select a menu command by using the keyboard 

1. Press ALT or F10 to make the menu bar active.  
2. Press the underlined key in the menu name to open the menu. 
3. Press the underlined key in the command name. 

♦ To select a menu command by using the mouse 

1. Click the menu name to open the menu. 
2. Click the menu command. 

Using Fields on Windows 
The windows in SoftMed programs contain several types of fields for entering 
information and setting options. This section describes each field and explains how to 
use the mouse and keyboard with each field. 

Typing and Editing Text 
Use a box with a white background to type or edit 
text. 

♦ To type or edit text by using the keyboard 

1. Press tab to move to the box. 
2. Type the text that you want to appear in the field. 

♦ To type or edit text by using the mouse 

1. Click the box. 
2. Type the text that you want to appear in the field. 

Note: Some text fields have specific 
formatting requirements. ChartScript 
checks the data entered and displays any requirements that need to be met in the status 
bar at the bottom of the window. 

Setting Dates 
In date fields, you do not need to type slashes between the month, day, and year. 
SoftMed inserts the slashes automatically. Also, if you type a single digit for the month 
(not 1) or day (not 1 or 2), SoftMed automatically inserts a zero as the first digit. For 
example, if you type 3702, the date appears as 03/07/2002. 
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Use the following shortcuts to enter and change dates in date fields. 

Key Result 

t Inserts the current date in the date field. 

y Inserts the previous day’s date in the date field. 

f Inserts the first day of the current month in the date field. 

e Inserts the last day of the current month in the date field. 

- (minus) Prompts you to enter the number of days before the current date. 
ChartScript calculates the date and inserts it in the field. 

+ (plus) Prompts you to enter the number of days after the current date. 
ChartScript calculates the date and inserts it in the field. 

 

You can use the following shortcuts to change dates in date fields. 

Key Result 

p (plus) Increases the date by one day. 

m (minus) Decreases the date by one day. 

 

Setting Times 
In time fields, it is not necessary to type the colon (:) 
between the hour and minute. SoftMed inserts the colon 
automatically. Some of the time fields are formatted to 
display time in A.M./P.M. format. However, you can enter the time value in this field using 
military time and ChartScript will convert the time to A.M./P.M. 

After pressing TAB or ENTER, the dictation time above 
becomes 

Selecting Check Box Options 
Use a check box to turn an option on or off. You can select more than 
one check box in a group. 

♦ To select a check box option by using the keyboard 

1. To select, press tab to move to the check box and then press spacebar. A check 
mark appears in the box. 

2. To clear, press spacebar again. 

♦ To select a check box option by using the mouse 

1. To select, click the box. A check mark appears in the box. 
2. To clear, click the box again. 
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Selecting Items from a List 
Use these fields to make a single choice from a list of 
options. 

 

♦ To select an item from a list by using the keyboard 

1. Press TAB to move to the field. 
2. Press ALT and DOWN ARROW at the same time to display a list of options. 
3. Press DOWN ARROW or UP ARROW to move through the list of options. 

4. When the option that you want is selected, 
press ENTER. 

Note: If you know the keystrokes for the desired 
selection, type them rather than opening the list, and then press ENTER. 

♦ To select an item from a list by using the mouse 

1. Click the arrow or list button to display a list of options. 
2. Click the option that you want to select. 

 
 

 

Selecting Options 
Use this field to select an option from a group of options. You 
can select only one option in each group. 

♦ To select an option by using the keyboard 

1. To select, press the underlined letter in the option name. 
A dark circle appears. 

2. To clear, press the underlined letter of another option name. 

♦ To select an option by using the mouse 

1. To select, click the field. A dark circle appears.  
2. To clear, click another field in the group. 
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Selecting Providers 
The provider fields in ChartScript retrieve data from the ProviderID database. You can 
search for a provider using the provider’s name or primary identification number. When 
searching by primary identification number, ChartScript retrieves and enters the 
provider’s information into the field because only one provider is assigned that 
identification number. 

When searching by name, ChartScript may retrieve a list of providers who match the 
letter combination that you entered if more than one fit the criteria. 

Note: To ensure a faster and easier search, type 
specific search criteria. For example, typing only “wa” 
may retrieve several providers with 
last names that begin with “wa” in 
the Select One Provider window. 
However, typing “Walsh, P” retrieves 
fewer providers, making selection 
faster and easier. 

♦ To select a provider by using the 
keyboard 

1. Press down arrow or up arrow 
to move through the list. 

2. When the provider you want 
is selected, press enter. 

♦ To select a provider by using the 
mouse 

1. Click the provider that you 
want to select. 

2. Select OK. 

Typing Numeric Identifiers 
A few of the document and patient identification fields are 
programmed to zero fill automatically if the number does 
not contain as many digits as the field is set to accept. 

After pressing TAB or ENTER, the medical record number 
above becomes: 

Disabled Fields 
A box with a gray background 
displays information that you cannot 
change using the current window. 
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ChartScript Menus 

Documents Menu 
Use the Documents menu to add, edit, and purge documents. 

 

 

 

 

 

Reports Menu 
Most of the reports on the Reports menu are for 
administrative work. Select the Users Documents 
report to view a summary of your transcription 
activity. 
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                   Appendix B: ChartScript Menus and Toolbar  B-2 

Maintenance Menu 
The Maintenance menu enables 
administrators to perform a variety of 
maintenance tasks on the database. 

 

 

 

 

Management Control Menu 
The Management Control menu enables administrators to 
set up tables, set parameters, set up incentive plans, define 
fields, and perform other managerial functions. 

 

 

 

 

Import Menu 
The Import menu contains functions 
related to document importing and 
patient interface records. 

You will be reminded occasionally to 
refresh your In-House Backup files 
using this menu. 

Options Menu 
Use the Options menu commands to 

! Display the Login window 
! Activate ChartScript Express mode 
! Define your own VoiceScript settings 
! Choose a different working mode 
! Create text inserts 
! Customize your toolbar 
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Help Menu 
Use the Help menu to display Help for ChartScript. 

 

Toolbar 
The table below describes the buttons on the ChartScript 
toolbar. 

Button Description 

  

Searches for patient data to use in creating a new document. 

  

Searches for existing documents that you can edit, reprint, or view 
document details. 

  

Runs a user-defined report of ChartScript data. 

  

Prints documents in batch mode. 

  

Displays graphical comparisons of transcription activity by 
transcriptionist or by document type. 

  

Imports documents to ChartScript from an outside source. 

  

Displays ChartScript Help. 

  

Quits ChartScript. 
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APPENDIX C 

 

SoftMed Data Sharing 
Process 

Patient is
registered in
the facility's
host system

ChartLinc
receives

patient data via
standard ADT
interface and

document
upload.

Provider enters
job information
into the digital

dictation
system

DDSI receives
dictation data
via standard

DDSI interface

ChartLinc, Voicescript,
and DDSI data, as well

as VoiceScript
dictation, is available to

transcriptionist in
ChartScript

Transcriptionist types
and saves a document

in ChartScript

Provider(s) edit,
review, and/or sign

documents
in ESA

ChartFact
deficiencies are

updated using CFL
Updater

ADT feed from
host system to

ChartScript

Upload of unreviewed
document to host

system

Upload of reviewed
or signed document

to host system
Update and/or

remove deficiency

Update deficiency
to an S or hold

Create or update
deficiency to a T

Provider enters job
information and dictates

using VoiceScript
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APPENDIX D 

 

In-House Backup 
Document Merge Process 

ChartScript Document
(body of the document is inserted into the format file) 

Document is saved in the ChartScript database. 

Move in-House Backup Documents 
from Local PC to Network 

Document is moved to the 
\\Softmed\Script\Impauto folder on 
the network and is imported into 
ChartScript. 

In-House Backup Document 
(no template, body of the document only) 

Document is saved in the C:\Ihbkup\Work 
folder on the workstation. 
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SoftMed 
Term Description 

SSIMenu Login Your user ID and password that allow you access to SSIMenu and any 
other programs to which you are linked. 

SSIMenu Gateway to all SoftMed programs. SSIMenu stores global code for all 
SoftMed applications, such as field sizes and facility codes. 

CUT The Central User Table is a centralized master list of users and their 
access to SoftMed applications. Users have one user ID and one 
password to access all of the applications to which they are linked. 

CDTT The Central Document Type Table is a centralized master list of the 
document types available in SoftMed. The central document ID in the 
CDTT is linked to the document type table in each program to create an 
integrated solution. 

INTERFACES 

ChartLinc SoftMed patient interface that translates and transfers patient 
Admission/Discharge/Transfer information from the mainframe to 
SoftMed products, such as ChartScript and ChartFact. 

DDSI SoftMed Digital Dictation System Interface that transfers dictation 
information from a facility’s dictation system to ChartScript. DDSI also 
updates ChartFact dictation deficiencies. 

AUXILIARY PRODUCTS 

ChartFax 
SE/EE 

A SoftMed product that allows clients to fax or e-mail physician carbon 
copies or fax ChartFact letters.  

ESA Electronic Signature Authentication. Providers use ESA to view, edit, 
and sign documents using a computer. 

OTHER SOFTMED PRODUCTS 

ChartFact Deficiency tracking software. ChartFact deficiencies are updated by 
other SoftMed products, such as DDSI (physician dictation), ChartScript 
(transcription), or ESA (electronic signature authentication). 

ProviderID Provider database that stores each provider’s profile. 

APPENDIX E 

 

ChartScript Glossary 



 

                   Appendix E: ChartScript Glossary E-2 

SoftMed 
Term Description 

ChartID Master patient index (MPI) program or a backup MPI of the facility’s 
mainframe system. 

CHARTSCRIPT TERMS 

Script Login First-time only login to link a user’s ChartScript user ID to his or her 
SSIMenu user ID. 

Stat Print Immediately after the document is typed, the user selects an option 
from a menu to direct how and where the document prints. This type 
of printing is generally used for documents that are needed 
immediately at various locations. 

Batch Print Documents are saved and then printed together all at one time in a 
batch, based on criteria that you specify. 

Reprint A transcribed document is printed on demand in Edit mode. 

CCs – Provider 
Copy 

This copy is printed for each provider added via the ChartScript CC 
function. The name of each provider prints at the bottom of each copy. 

Extra copy An additional copy that is neither the original/chart copy nor the 
physician/carbon copy. Extra copies are typically special requests or for 
a department’s records. 

Print Rules A set of instructions that tells ChartScript how and where to print a 
document. When doing immediate print jobs, such as stat printing and 
reprinting, transcriptionists must select a print rule before the 
document can be printed. Batch printing can be set up with the print 
rule already selected for each batch. Therefore, it is a seamless process 
for the transcriptionist. 

Document 
Upload 

The Document Upload interface is an optional feature in ChartScript 
that enables a facility to send transcribed documents to an online data 
repository. 
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If your facility uses VoiceScript, you can define your own VoiceScript settings without 
assistance from a supervisor.  

♦ To define VoiceScript dictation playback settings  

1. From the Options menu in ChartScript, select VoiceScript Settings. 
2. On the VoiceScript Settings window, 

specify your settings. 
The User and workstation settings are defined 
as follows: 

! Prompt Level. Select Verbose or Brief for a 
long or short version of the same prompt, 
respectively. If you are new to VoiceScript, 
you may prefer verbose prompts until you 
become more familiar with the product. 
On the other hand, more experienced 
transcriptionists or those who handle a 
high volume of dictation records may 
prefer shorter prompts, which enable them 
to proceed more quickly through the 
transcription process. For a list of these 
prompts, see the Appendix of the 
VoiceScript Management Guide.  

! Welcome Prompt. Select this check box if you want to hear a standard welcome 
prompt after logging on to VoiceScript. 

! Speed Increment. Select a number from 1 to 5 to indicate the degree of increase (or 
decrease) for the prompt play speed based on a normal speed of 0.  

! Volume Default. Select a number from –5 to 5 to set your default prompt volume 
level based on a normal volume level of 0. 

! Volume Increment. Select a number from 1 to 5 to indicate the degree to which the 
volume will increase each time you press the volume key. 

! Rewind Distance. Select a number from 1 to 60 to indicate how far back the system 
will rewind, in seconds, each time you elect to rewind. 

! Forward Distance. Select a number from 1 to 60 to indicate how far ahead the 
system will fast-forward, in seconds, each time you elect to fast forward. 
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! Audible Rew/Fwd Cue. Select this check box if you want to hear a sound indicative 
of rewinding or fast forwarding. 

! Play Standby Tone. Select this check box to produce a beep during a pause in 
recording. 

! Pause Mode Increment. Select a number to indicate at what interval the playing of 
the standby tone will occur in seconds.  

! Stop Mode Increment. Select a number from 1 to 60 to indicate the number of 
seconds of dictation time that the system rewinds when dictation playback is 
stopped. This setting ensures that you resume transcription in the correct part of the 
dictation. 

! Preferred Playback Mode. Select your dictation playback preference. Select Prompt 
(always ask) to be prompted for playback preference after selecting VoiceScript on 
the Search for and Add Documents window. Select any of the remaining options, 
Digital playback through ChartScript, Analog playback through VoiceModem, 
Analog playback through ChartScript, or Analog playback through telephone, to 
bypass a selection prompt and make the selected option the default. 

! VoiceServer Phone Number. Select the phone number that you must dial to access 
the Voice Server, if using a Voice modem. These numbers are entered and 
maintained in the Administrator. 

! VoiceModem COM Port. The port on which the Voice Modem is installed. 
! Audible VM Connect. Select this check box to hear the Voice modem connection 

process.  
! Audible VM Commands. Select this check box to hear commands sent after voice 

modem connection. 

The table below describes the buttons on the VoiceScript Settings window. 

Button Description 

 

Closes the window, saving any changes that you have made. 

 

Closes the window without saving changes. 

 

Select this button to query the voice modem for configuration 
information. A message appears indicating whether essential files 
are missing. 

 

Select this button to reset your voice modem connection after an 
inactivity timeout or phone line problem. Selecting this button 
prevents you from having to exit and re-enter ChartScript to clear 
the connection. 
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